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Copyright 

The Competency-based Learning Material (Student Guide) for Pattern Making, Grading and CAD-CAM 

Operation is a document, aligned to its applicable competency standard, for providing training consistent 

with the requirements of industry in order for individuals who graduated through the established standard 

via competency-based assessment to be suitably qualified for a relevant job. 

This document is owned by the Finance Division of the Ministry of Finance of the People’s Republic of 

Bangladesh, developed under the Skills for Employment Investment Program (SEIP). 

Public and private institutions may use the information contained in this competency-based learning 

material for activities benefitting Bangladesh. 

Other interested parties must obtain permission from the owner of this document for reproduction of 

information in any manner, in whole or in part, of this Competency-based Learning Material, in English or 

other language. 

This document is available from:  

Skills for Employment Investment Program (SEIP) Project 

Finance Division 

Ministry of Finance 

Probashi Kallyan Bhaban (Level – 16) 

71-72 Old Elephant Road 

Eskaton Garden, Dhaka 1000 

Telephone: +8802 551 38598-9 (PABX), +8802 551 38753-5 

Facsimile: +8802 551 38752 

Website: www.seip-fd.gov.bd 
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How to Use this Competency-based Learning Material 

Welcome to the competency-based learning material for Pattern Making, Grading and CAD-CAM 

Operation for use in leather goods and footwear manufacturing works.  These modules contain training 

materials and learning activities for you to complete in order to become competent and qualified as a skilled 

worker. 

There are five (5) modules that make up this course which comprises the skills, knowledge and attitudes 

required to become a skilled worker including: 

1. Understand pattern making and CAD-CAM Operation 

2. Carry out manual pattern making operations 

3. Prepare standard/shell using 3D software 

4. Performing computer-aided pattern making operation using 2D software 

5. Carry out pattern grading 

As a learner, you will be required to complete a series of activities in order to achieve each learning 

outcome of the module.  These activities may be completed as part of structured classroom activities or 

simulated workplace demonstrations. 

These activities will also require you to complete associated learning and practice activities in order to gain 

the skills and knowledge needed to achieve the learning outcomes.  You should refer to Learning Activity 

pages of each module to know the sequence of learning tasks and the appropriate resources to use for 

each task. 

This page will serve as the road map towards the achievement of competence.  If you read the Information 

Sheets, these will give you an understanding of the work, and why things are done the way they are.  Once 

you have finished reading the Information Sheets, you will then be required to complete the Self-Check 

Quizzes.  

The self-check quizzes follow the Information Sheets in this learning guide.  Completing the self-check 

quizzes will help you know how you are progressing.  To check your knowledge after completion of the 

Self-Check Quizzes, you can review the Answer Key at the end of each module. 

You are required to complete all activities as directed in the Learning Activity and Information Sheet.  

This is where you will apply your newly acquired knowledge while developing new skills.  When working, 

high emphasis should be laid on safety requirements.  You will be encouraged to raise relevant queries or 

ask the facilitator for assistance as required. 

When you have completed all the tasks required in this learning guide, formal assessment will be scheduled 

to officially evaluate if you have achieved competency of the specified learning outcomes and are ready for 

the next task. 
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Module 1: Understand pattern making and CAD-CAM operation 

 

 

MODULE CONTENT 

 

Module Descriptor: This module covers the skills, knowledge and attitudes to understand pattern making 
and CAD-CAM operations. The module covers the tasks of describing concept of pattern making, 
identifying requirements for CAD-CAM operations, devices and hardware required for CAD-CAM 
operations. It also includes information sheets, job sheets, self-checking, answer keys and assessment 
plan. 

 

Nominal Duration: 12 hours 

 

 

LEARNING OUTCOMES:  

 

Upon completion of the module, the student/trainee should be able to: 

1.1 Describe concept of pattern making 
1.2 Identify basic requirements for CAD-CAM operations 
1.3 Identify devices and hardware required for CAD-CAM operations 

 

 

 

                      PERFORMANCE CRITERIA: 

 

1. Basic styles of footwear are identified. 
2. Shoe construction is explained and illustrated. 
3. Types of lasts are identified and categorised. 
4. Reference points for last are identified. 
5. Concept of pattern making is clearly defined. 
6. CAD-CAM operations are appropriately identified. 
7. Functions of CAD-CAM systems are identified and described. 
8. Basic CAD-CAM software is identified. 
9. CAD-CAM devices required for effective operation are identified. 
10. Use of CAD-CAM hardware is carried out. 
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Learning Outcome 1.1 - Describe Concept of Pattern Making 

 

 

 

Contents: 

 

▪ Basic styles of footwear 
▪ Shoe construction 
▪ Types of last 
▪ Reference points of last 
▪ Concept of pattern making 

 

 

Assessment criteria: 

 

1. Basic styles of footwear are identified. 
2. Shoe construction is explained and illustrated. 
3. Types of lasts are identified and categorised. 
4. Reference points for last are identified. 
5. Concept of pattern making is clearly defined. 

 

 

Resources required: 

 

Students/trainees must be provided with the following resources: 

▪ Personal Protective Equipment (PPE): gloves, safety shoes, working clothes, apron 
▪ Tools and equipment: measuring tape, different types of last 

 

 

   LEARNING ACTIVITY 1.1.1 

 

Learning Activity Resources/Special Instructions/References 

Describing concept of pattern making ▪ Information Sheet: 1.1.1 

▪ Self-Check: 1.1.1 

▪ Answer Key: 1.1.1 

▪ Group Activity 

 

 

 INFORMATION SHEET 1.1.1 

 

Learning Objective: to describe concept of pattern making. 
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1. Basic styles of footwear- Footwear is an envelope of foot which covers and protects the foot from 
outer influences. Basic styles of footwear are oxford, derby, court, slip-on, moccasin, boot and 
sandals. 

Oxford shoe 

✓ Most widely used as formal shoes  

✓ Unisex 

✓ Quarter is locked at the vamp point and hence 
opening of the quarter is limited 

✓ An independent tongue is stitched at the final 
stage of the upper 

✓ In all cases vamp will on the quarter (vamp up 
on the quarter) Oxford= V/Q 

 

Derby shoe 

➢ A very wide range of styles can be derived from 
a derby design 

➢ Unisex 

➢ Can be identified from the following points: 

a. Lock stitch (or) stay stitch 

b. The quarter can be opened till half of the tread 
line 

c. The vamp and the tongue will be on the same 
line 

d. In all cases quarter will be on the vamp. 
(Quarter up on the vamp) Derby=Q/V 

 

Court shoe 

➢ It has an unbroken top line 

➢ The top line will be below the vamp point 

➢ Can be made in different heel heights 

➢ Three quarter vamp and opening are maximum 
 

Slip-on/Casual 

Slip on also called as Pantafola and Loafer. 

➢ As the name indicates these shoes can be slipped 
in and slipped out very easily 

➢ Does not have lace 

➢ Can be with or without elastic 

➢ Saddle is present in most of these designs  
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Moccasin 

➢ The most comfortable shoe to wear 

➢ Expensive as more leather is consumed 

➢ Formal and casual shoe 

➢ Hand stitching/moccasin stitch gives a good 
appearance 

➢ Bottom will be covered with upper material at the 
fore part 

When the whole bottom Is covered by upper 
materials, the shoe is known as driving shoes. 

 

Boot 

➢ Top line crosses above the ankle bone. 

➢ Casual shoes popular among teenagers, gents 
and ladies 

➢ Different types of boots are ankle boot, high boot, 
knee boot and thigh boot 

 

Sandals 

➢ A popular Unisex foot wear which is very 
comfortable 

➢ The foot is free at the toe and heel 

➢ The sandals serve according to the specific 
needs as the length can be adjusted  

➢ Fastening device like buckle, velcro, elastic, etc. 
is present 

When the foot heel and toe is covered up then the 
sandal is known as cycle shoes. 

 

Sports Shoe 

➢ Mostly athletic shoe 

➢ Number of eyelets will be higher 

➢ Flexible, soft and comfortable  

➢ No shank  

➢ Flat sole 

➢ Used for running, jumping, hiking, riding and any 
others physical activities 

 

 

Shoe construction 

The term shoe construction means attachment of upper with sole. They are as follows: 

1. Stuck on or cemented construction. 

2. Moulded construction. 

       a) Direct vulcanization (specially done for rubber sole) 

       b) Injection moulded (TPR, PVC, TPU) 
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c) PU casting/pouring 

3. Californian slip lasted construction. 

4. String lasted construction (for DIP shoes). 

5. Strobel construction (for DIP shoes). 

6. Stitch down construction 

a. San crispino 

b. Veldtschoen 

7. Good year welted 

Advantages of moulded construction: 

1. Easy to make 

2.  Less time required 

3.  Semi-skilled person is required 

4.  High quality with low price 

5.  High productivity 

Disadvantages of moulded construction: 

1.  Less longevity 

2.  Less elegant 

3.  Not versatile and not luxurious. 

In the direct shoe construction, the upper is attached directly to the sole without any via material. However, 
in indirect construction the upper is attached with sole indirectly, i.e. via other material, such as welt, 
midsole, rib, etc. Shoes made by indirect construction are highly fashionable, elegant and durable. 

Last and their types - A last is a mechanical form that has a shape similar to that of a human foot. It is 
used by shoemakers and cordwainers in the manufacture and repair of shoes. Lasts are different types (i.e. 

Solid block, Scoop, V-hinge, C-hinge and Thong last). 

 

1. Solid block last: It is use for sandal, chappal (Open 
footwear) and moccasin shoes. 

 

 

2. Scoop last: It is use for closed footwear.  

 

3. V-Hinge last: It is also use for closed footwear making. 
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4. C-hinge last: It is use for closed footwear. 

 

 

 

 

5. Thong last:  It is used for strap sandal making. 

 

 

Materials for last: 

✓ Wood 

✓  Plastic (HDPE-High Density Poly Ethylene) 

✓  Aluminium last  

✓  Steel last 

✓  Alloy 

 

Reference points of last- Toe point, inside 
ball point, outside ball point, instep point, 
waist point, vamp point, seat point, back 
height point and feather edge.  

Measurement of last:1.SL: Last length, 2. 
Bottom width, 3.Ball width, 4. Ball girth 
5.Waist Girth,6. Heel height, 7. Toe spring 8. 
Trade line, 9. Long heel girth 10. Short heel 
girth. 

 

Concept of pattern making 

Pattern is the flat representation of three-dimensional figure into two-dimensional form. The pattern 
engineer is the professional that translates the ideas of the designer into a product and engineering of the 
patterns for upper and lining. A pattern maker needs to have a good knowledge of: 

• the entire manufacturing processes. 

• the development of the shoe last and of all the bottom components such as insoles, soles and heels 

• the different materials that can be used in production such as leathers, synthetics and fabrics 

The pattern making techniques are fundamental to the design process that leads to the creation of a 
footwear collection. 

The first step of pattern making is to convert the 3D shape of the last into a flattened 2D shape which is 
usually called ‘Mean form’. When style lines and the lasting allowance are added into the 2D shape of the 
last, the form can be called ‘Standard’. The patterns are cut out from this standard and stitched together 
to create the 3D footwear design. These steps are made for the typical sample size. 
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But firstly, the last must be controlled and evaluated by using references of measures considered as a 
‘starting point’. There are many ways of making the form, but all follow the same system of finding some 
reference points and lines along the surface of the last. Then the masking tape is used to cover the surface 
of the last and then removed to be flattened. 

Mark the outside and inside tangent points along the feather edge. Then, by the measuring tape trace the 
fitting line and the ‘Last Fitting Point’ (LFP). 

PATTERN MAKING ACTIVITY: 

❖ Select a specific design 

1.   Preparation of tools 

• Last 

• Masking tape 

• NT cutter 

• Measuring tape 

• Pencil 

• Eraser  

• Pattern paper 

• Cutting board 

• Sharpener 

• Pricker 

• Scale  

• Divider 

• French curve 

Manual pattern making: 

• Mask the whole last with the masking tape  

• Perform on last design 

• Take the main points, like-back height points, vamp points, ball points. These points are fixed for all 
design. 

• Draw the style line for the desired style. 

• Make the stencil cut. 

• Take out the outside form and flatten on the pattern paper carefully. 

• Take out the inside form and flatten on the pattern paper carefully. 

• Smooth the masking tape area of both the inside and outside form. 

• Cut at the outer edge of the masking tape and take out the inside and outside form. 

• Trace the outside form margin on the pattern paper keeping masking tape out and mark the outside 
ball point, vamp point, toe point and back height point. 

• Trace the inside form outline on the outside form sketch keeping masking tape in and matching both 
the ball point, toe point and back height point accurately. 

• Draw mean (average) through the centre line and make the mean form by taking the outer line of inside 
and outside form. 

• Trace mean form on pattern paper and create a standard for any specific design 

• Develop Upper and lining standard for any particular design. 
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• Develop and cut the all sectional pattern for upper components.  

• Develop and cut the sectional pattern for lining components.  

• Develop and cut the sectional pattern for toe puff and counter stiffener components.  

• Develop and cut the all sectional pattern for bottom components (e.g. insole, sole and heel).  

 

 

SELF-CHECK QUIZ 1.1.1 

 

Check your understanding by answering the following questions: 

1. What is footwear?  

2. What are the basic styles of footwear?  

3. What is meant by a last? 

4. Name five different types of last. 

5. Which last is used for making strap sandal? 

6. Mention five important last reference points. 

7. Why moccasin is the most comfortable to wear?  

8. What is a cycle shoe?  

9. What is meant by term “shoe construction”?   

10. What is a driving shoe?  

Fill in the blanks with the correct answer.  

11. Footwear is an ____________ of foot. 

12. Court shoe has ____________ top line. 

13. Moccasin is the most __________ to footwear. 

14. Shoes made by _______   ______ are highly fashionable, elegant and durable. 

15. C-hinge last is use for ____________________. 
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Learning Outcome 1.2 - Identify Basic Requirements for CAD-CAM Operations 

 

 

 

 Contents: 

 

▪ CAD-CAM operations 
▪ Functions of CAD-CAM systems 
▪ Basic CAD-CAM software 

 

 

 Assessment criteria: 

 

1. CAD-CAM operations are appropriately identified. 
2. Functions of CAD-CAM systems are identified and described. 
3. Basic CAD-CAM software is identified. 

 
 
 

Resources required: 

 

Students/trainees must be provided with the following resources: 

▪ Personal Protective Equipment (PPE): gloves, safety shoes, working clothes, apron 
▪ Tools and equipment: CAD-CAM system 

  

 

LEARNING ACTIVITY 1.2.1 

 

Learning Activity Resources/Special Instructions/References 

Identifying basic requirements for CAD-CAM 
operations  

▪ Information Sheets: 1.2.1 

▪ Self-Check: 1.2.1 

▪ Answer Key: 1.2.1 

https://www.youtube.com/user/caddsoftsolutions 

 

 

 INFORMATION SHEET 1.2.1 

 

Learning Objective: to identify basic requirements for CAD-CAM operations. 

CAD-CAM operations 

Computer-aided design (CAD) is the use of computer systems to assist in the creation, modification, 
analysis, or optimization of footwear design. CAD software is used to increase the productivity of the 
designer, improve the quality of design, improve communications through documentation, and to create a 

https://www.youtube.com/user/caddsoftsolutions
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database for manufacturing. It is an important industrial art extensively used in shoe and last designing. It 
may be used to design curves and figures in two-dimensional (2D) space; or curves, surfaces, and solids 
in three-dimensional (3D) space. CAD output is often in the form of electronic files for print, machining, or 
other manufacturing operations. 

Computer-aided manufacturing (CAM) is the use of computer software to control machine tools and related 
machinery in the manufacturing of footwear. CAM may also refer to the use of a computer to assist in all 
operations of a manufacturing plant, including planning, management, transportation and storage. Its 
primary purpose is to create a faster production process and components and tooling with more precise 
dimensions and material consistency. Plotter is used to cut the pattern. 

CAD/CAM in the footwear industry: 

CAD/CAM in the footwear industry is the use of computers and graphics software for designing and 
grading of shoe patterns and, for manufacturing of cutting dies, shoe lasts and sole moulds. CAD/CAM 
software is a PC-based system, which is made up of program modules. There are 2D and 3D versions of 
CAD/CAM systems in the shoe industry. 

Digitizer, scanner, touch pad, etc. are used as input devices for CAD/CAM system. 2D pattern can be 
transferred to CAD system through digitizer. 

CAD was used primarily for pattern grading. It 
enabled manufacturers to perform complex 
grading relatively easily and quickly. Logos, 
textures and other decorations can be 
incorporated into product designs of both the 
uppers and soles to help reinforce branding on 
all areas of the model. It automates routine 
procedures, increasing speed and consistency 
whilst reducing the possibility of mistakes. CAD 
data can now be used effectively for a wide 
variety of activities across footwear 
manufacturing business. CAD/CAM generates 
data at the design stage, which can be used 
right through the planning and manufacturing 
stages. 

Latest improvements in the CAD/CAM 
technology: 

• Graphic capabilities and interconnectivity have improved enormously. 

• Software developments have progressively made systems more intuitive and easier to use. 

• With 2D sketch and paint modules, a serviceable sketch can be produced and then colour, and texture 
can be added. 

• 3D systems enable the last and design to be viewed from any perspective and several angles even 
simultaneously. 

With CAD/CAM software, footwear manufacturers can cut their time to market dramatically and so increase 
market share and profitability. In addition, the power and flexibility of the software can overcome 
restrictions to the designer’s creativity imposed by traditional methods. 

Use/functions of CAD-CAM systems: 

❖ 3D last scanning 

❖ Pattern making 

❖ Digitizing 

❖ Pattern engineering 

❖ Visualizing 

❖ Grading 

❖ Pattern cutting 
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❖ Consumption of materials 

Advantages of CAD-CAM: 

1. Increased productivity 

2. Error free drafting 

3. Repeatability 

4. Lower overhead costs 

5. Designs can be altered with minimal effort 

6. Improved collaboration 

7. Three-dimensional modelling 

8. Ability to create a sectional view 

Disadvantages of CAD-CAM: 

1. Software is very expensive 

2. Special skills manpower is required 

3. Expensive machine required 

4. High maintenance cost 

5. Nature of materials of the object 

Basic CAD-CAM software for footwear: 

➢ ShoeMaster 

➢ Crispin 

➢ Auto CAD 

➢ Romans CAD 

➢ Iron CAD 

➢ Edge CAD 

➢ Tube CAD 

➢ Rhino 

➢ Fast shoe 

➢ Horse shoe 

➢ Dimension 

➢ ICad 3D+ 

Industry Visit:  

• Visit a footwear industry nearby. 

• Observe the following activities in pattern making and CAD-CAM section: 

-  What tools and equipment are being used? 

-  Are there sufficient lighting and ventilation facilities in the workplace? 

-  Anything more observed by you 

• Fill-up the ‘Industry Visit Format’ given in your workbooks. 

• Present the experience group wise as per instruction of your trainer. 
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INDUSTRY VISIT FORMAT 

Date of Visit Learner Name/s 

Name of industry with 
location 

 

 

Objectives of visit  

Works/Tasks observed  

 

Learning /Experiences  

 

 

Learner Signature:  Date:  

Trainer Signature:  Date:  

Note: Please add extra sheet if necessary 

 

 

SELF-CHECK QUIZ 1.2.1 

 

Check your understanding by answering the following questions: 

1. What is meant by CAD-CAM?  

2. What are the functions of CAD-CAM system? 

3. Mention five CAD-CAM software used in footwear industry. 

4. Give an example of CAM in footwear industry. 

5. Mention the input devices used in CAD system.   

Fill in the blanks with the correct answer.  

6. CAD software is used to increase the _________ of the designer. 

7. 2D pattern can be transferred to CAD system through ____________. 

8. CAD was used primarily for _______________. 

9. _____________ is used to cut the pattern. 

10. One of the uses of CAD-CAM is _________________ productivity. 
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Learning Outcome 1.3 - Identify Devices and Hardware Required for CAD-CAM 
Operations 

 

 

 

 Contents: 

 

▪ CAD-CAM devices  
▪ Use of CAD-CAM hardware 

 

 

 Assessment criteria: 

 

1. CAD-CAM devices required for effective operation are identified. 
2. Use of CAD-CAM hardware is carried out. 

 

 

Resources required: 

 

Students/trainees must be provided with the following resources: 

▪ Personal Protective Equipment (PPE): gloves, safety shoes, working clothes, apron 
▪ Tools and equipment: CAD, CAM 

 

 

LEARNING ACTIVITY 1.3.1 

 

Learning Activity Resources/Special Instructions/References 

Identifying devices and hardware required 
for CAD-CAM operations  

▪ Information Sheets: 1.3.1 

▪ Self-Check: 1.3.1 

▪ Answer Key: 1.3.1 

https://ww.youtube.com/watch?v=KzxVZgO-iOA 

 

 

 INFORMATION SHEET 1.3.1 

 

Learning Objective: to identify devices and hardware required for CAD-CAM operations. 

CAD-CAM devices  

Pointing stick:  

A pointing stick (or nipple mouse, or "Nub," or "Titmouse") is a small 
joystick used as a pointing device typically mounted centrally in a computer 
keyboard.  

https://ww.youtube.com/watch?v=KzxVZgO-iOA
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Graphics tablet: 

A graphics tablet (also known as a pen tablet, drawing 
tablet or digitizer) is a hardware input device used 
primarily by digital artists, though many non-artists use 
them as well. Graphics tablets have a hard plastic, touch-
sensitive drawing surface that transfers stylus or mouse 
movements to a monitor. 

 

 

 

Joystick: 

Joystick is a lever that moves in all directions and controls 
the movement of a pointer or some other display symbol. A 
joystick is similar to a mouse, except that with a mouse 
the cursor stops moving as soon as you stop moving the 
mouse. With a joystick, the pointer continues moving in the 
direction the joystick is pointing. To stop the pointer, you 
must return the joystick to its upright position. Most joysticks 
include two buttons called triggers. Joysticks are used 
for CAD/CAM systems and other applications. 

Light pen: 

A light pen is a computer input device in the form of a light-sensitive 
wand used in conjunction with a computer's cathode-ray tube (CRT) 
display. 

It allows the user to point to displayed objects or draw on the screen 
in a similar way to a touch screen but with greater positional 
accuracy. A light pen can work with any CRT-based display, but its 
ability to be used with LCDs was unclear. 

Mouse: 

A computer mouse is a hand-held pointing device that 
detects two-dimensional motion relative to a surface. This 
motion is typically translated into the motion of a pointer on 
a display, which allows a smooth control of the graphical user 
interface. Originally wired to a computer, many modern mice 

are cordless, relying on 
short-range radio 
communication with the 
connected system. Mice 
originally used a ball rolling 
on a surface to detect 
motion, but modern mice often have optical sensors that have no 
moving parts. In addition to moving a cursor, computer mice have one 
or more buttons to allow operations such as selection of a menu item 
on a display.  

Touch pad: 

A touchpad or track pad is a pointing device featuring a tactile 
sensor, a specialized surface that can translate the motion and 
position of a user's fingers to a relative position on the operating 
system that is made output to the screen. Touch pads are a 
common feature of laptop computers and are also used as a 
substitute for a mouse where desk space is scarce. Because they 
vary in size, they can also be found on personal digital 
assistants (PDAs) and some portable media players. Wireless 
touch pads are also available as detached accessories. 

https://www.webopedia.com/TERM/P/pointer.html
https://www.webopedia.com/TERM/M/mouse.html
https://www.webopedia.com/TERM/C/cursor.html
https://www.webopedia.com/TERM/B/button.html
https://www.webopedia.com/TERM/C/CAD_CAM.html
https://www.webopedia.com/TERM/S/system.html
https://www.webopedia.com/TERM/A/application.html
https://en.wikipedia.org/wiki/Computer
https://en.wikipedia.org/wiki/Input_device
https://en.wikipedia.org/wiki/Cathode-ray_tube
https://en.wikipedia.org/wiki/Touchscreen
https://en.wikipedia.org/wiki/Liquid-crystal_display
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Touch screen: 

A touch screen is a computer display screen that 
serves as an input device. When a touch screen is 
touched by a finger or stylus, it registers the event and 
sends it to a controller for processing. A touch 
screen may contain pictures or words that the user 
can touch to interact with the device. 

 

 

 

 

Image scanner: 

An image scanner is an electronic device which can read 
or scan graphics, text or handwritten document and 
translate it into an electronic format that the computer can 
understand. An image scanner is a digital device used to scan 
images, pictures, printed text and objects and then convert them 
to digital images. Image scanners are used in a variety of domestic 
and industrial applications like design, reverse engineering, 
orthotics, gaming and testing.  

Keyboard: 

A computer keyboard is 
one of the primary input devices used with a computer. Similar to 
an electric typewriter, a keyboard is composed of buttons that 
create letters, numbers, and symbols, as well as perform other 
functions. The following sections provide more in-depth 
information and answers to some of the more frequently asked 
questions about the keyboard. 

 

Use of CAD-CAM hardware: 

System unit: 

The system unit, also known as a "tower" or "chassis," is the main part of a desktop 
computer. It includes the motherboard, CPU, RAM, and other components. The system 
unit also includes the case that houses the internal components of the computer. 

Central processing unit (CPU): 

The central processing unit (CPU) is the unit 
which performs most of the processing inside a 
computer. To control instructions and data flow to 
and from other parts of the computer, the CPU 
relies heavily on a chipset, which is a group of 
microchips located on the motherboard. 

The CPU has two components: 

• Control Unit: extracts instructions from memory and decodes and 
executes them 

• Arithmetic Logic Unit (ALU): handles arithmetic and logical operations 

To function properly, the CPU relies on the system clock, memory, secondary storage, and data and address 
buses. This term is also known as a central processor, microprocessor or chip. 
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Memory: 

The computer memory is a temporary storage area. It holds the data 
and instructions that the Central Processing Unit (CPU) needs. 
Before a program can run, the program is loaded from some storage 
medium into the memory. The basic working unit of the computer's 
memory is a group of eight bits, which is called a byte. 

 

 

Hard disk: 

A hard disk drive (HDD), hard disk, hard drive, or fixed disk is 
an electromechanical data storage device that uses magnetic 
storage to store and retrieve digital information using one or 
more rigid rapidly rotating disks (platters) coated with magnetic 
material. The platters are paired with magnetic heads, usually 
arranged on a moving actuator arm, which read and write data 
to the platter surfaces. Data is accessed in a random-
access manner, meaning that individual blocks of data can be 
stored or retrieved in any order and not only sequentially. 
HDDs are a type of non-volatile storage, retaining stored data 
even when powered off. 

CD-ROM: 

CD-ROM stands for "Compact Disc Read-Only Memory." A CD-ROM is a CD that can be read by a 
computer with an optical drive. The "ROM" part of the term means the data on the disc is "read-only," or 
cannot be altered or erased. 

External storage device: 

External storage refers to all of the addressable data that is not stored on a 
drive internal to the system. External storage devices are commonly 
available in the form of flash drives, USB drives, CDs and DVDs. External 
storage is often used as a form of a backup or for transportation of data from 
one system to another. It can be used as a backup, to store achieved 
information or to transport data. External storage is not part of a computer's 
main memory or storage; hence it is called secondary or auxiliary storage. 

Monitor: 

A monitor is an electronic visual computer display that includes a screen, 
circuitry and the case in which that circuitry is enclosed. A computer 
monitor is an output device that displays information in pictorial form. A 
monitor usually comprises the display device, circuitry, casing, and power 
supply. A monitor is also known as a screen or a visual display unit (VDU). 

 

 

 

Printer: 

A printer is a peripheral device which makes a persistent human-readable 
representation of graphics or text on paper. Traditional printers are being 
used more for special purposes, like printing photographs or artwork, and 
are no longer a must-have peripheral. 

Starting around 2010, 3D printing became an area of intense interest, 
allowing the creation of physical objects with the same sort of effort as an 
early laser printer required to produce a brochure. These devices are in their 
earliest stages of development and have not yet become commonplace. 
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Plotter/cutter: 

The plotter is a computer printer for printing vector graphics. In the 
past, plotters were used in applications such as computer-aided design, 
though they have generally been replaced with wide-format conventional 
printers. A plotter gives a hard copy of the output. It draws pictures on a 
paper using a pen. 

Digitizer and puck: 

Digitizer (also known as drawing tablets, digitizer tablets, graphics tablets, drawing tablets, 
or CAD tablets) is an input device for converting analog to digital data using a single pointing device. 

It is an input device that enables you to enter drawings and 
sketches into a computer. A digitizing tablet consists of an 
electronic tablet and a cursor or pen. A puck is similar to 
a mouse, except that it has a window with cross hairs for pinpoint 
placement, and it can have as many as 16 buttons. The tablet 
contains electronics that enable it to detect movement of the 
cursor or pen and translate the movements into digital signals 
that it sends to the computer. For digitizing tablets, each point on 
the tablet represents a point on the display screen in a fixed 
manner. 

3D Scanner: 

3D scanner is used for scanning 3D last for the purpose of Shoe 
design. 3D scanning is the process of analysing a real-world object or 
environment to collect data on its shape and possibly its appearance 
(e.g. colour). The collected data can then be used to construct 
digital 3D models which is useful for a wide variety of applications. 

  

 

SELF-CHECK QUIZ 1.3.1 

 

Check your understanding by answering the following questions: 

1. Name five CAD-CAM devices. 

2. Describe the use of a light pen. 

3. Discuss the uses of CAD-CAM hardware. 

4. What is a CPU? 

5. Name some external storage devices. 

Fill in the blanks with the correct answer.  

6. A ____________ is a hand-held pointing device that detects two-dimensional motion relative to a 

surface.  

7. Touch pads are a common _____________ of laptop computers. 
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ANSWER KEYS 

 

ANSWER KEY 1.1.1 

1. Footwear is an envelope of foot which covers and protects the foot from outer influences. 

2. Oxford, Derby, Court, Slip-on, Moccasin, Boot and Sandals. 

3. A last is a mold similar in shape of a human foot upon which shoe is made.  

4. 1. Solid block, 2. Scoop, 3. V-hinge, 4. C-hinge and 5. Thong last 

5. Thong last. 

6. 1. Toe point, 2. Inside ball point, 3. Outside ball point, 4. Vamp point, 5.  Back height point. 

7. Because the bottom of the moccasin shoe is covered with upper material at the forepart. 

8. When the foot heel and toe is covered up then the sandal is known as cycle shoes. 

9. The term shoe construction means attachment of upper with sole. 

10. When the whole bottom is covered by upper materials, the shoe is known as driving shoes. 

11. Envelope. 

12. An unbroken. 

13. Comfortable. 

14. Indirect construction. 

15. Closed footwear. 

ANSWER KEY 1.2.1 

1. CAD/CAM refers to Computer aided design and Computer-aided manufacturing. 

2. Pattern making, digitizing, pattern engineering, grading, pattern cutting and consumption of materials. 

3. 1. ShoeMaster, 2. Crispin, 3. Romans CAD, 4. Rhino and 5. Fast shoe. 

4. Plotter and cutter. 

5. Digitizer, scanner, touch pad, etc. 

6. Productivity. 

7. Digitizer. 

8. Pattern grading. 

9. Plotter. 

ANSWER KEY 1.3.1 

1. CAD-CAM devices: 

(a) Graphics tablet 

(b) Joystick 

(c) Light pen 

(d) Touch screen 

(e) Image scanner 

2. Use of light pen. 

The light pen allows the user to point to displayed objects or draw on the screen in a similar way to 

a touch screen but with greater positional accuracy. 

3. Use of CAD-CAM hardware. 

https://en.wikipedia.org/wiki/Touchscreen


CBLM – Pattern Making, Grading and CAD-CAM Operation (Student Guide) v.1 Mar 2018    24 

Skills for Employment Investment Programme (SEIP) 

 

❖ System unit 

❖ Central processing unit (CPU) 

❖ Memory 

❖ Hard disk 

❖ CD-ROM 

❖ External storage device 

❖ Monitor 

❖ Printer 

❖ Plotter/cutter 

❖ Digitizer and puck 

4. CPU: The central processing unit (CPU) is the unit which performs most of the processing inside a 

computer. To control instructions and data flow to and from other parts of the computer, the CPU 

relies heavily on a chipset, which is a group of microchips located on the motherboard. 

5. External storage device: External storage devices are commonly available in the form of flash drives, 

USB drives, CDs and DVDs. 

6. Computer mouse. 

7. Feature. 
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Module 2: Carry out manual pattern making operation 

 

 

MODULE CONTENT 

 

Module Descriptor: This module covers the skills, knowledge and attitudes to carry out manual pattern 
making operations. The module covers the tasks of preparing mean form, developing standard/shell and 
cutting pattern from shell. It also includes information sheets, job sheets, self-checking, answer keys and 
assessment plan. 

 

Nominal Duration: 16 hours 

 

 

LEARNING OUTCOMES:  

 

Upon completion of the module, the student/trainee should be able to: 

2.1. Prepare a mean form 
2.2. Develop standard/shell 
2.3. Cut pattern from standard/shell 

 

 

 

                      PERFORMANCE CRITERIA: 

 

1. Mean form making process is identified and described. 
2. Last, pattern paper and masking tape are identified and selected. 
3. Mean form making is carried out as per job specification. 
4. Types of standard/shell are identified 
5. Upper standard/shell making is performed. 
6. Lining standard/shell making is carried out. 
7. Upper piece patterns are cut following upper standard. 
8. Lining piece patterns are cut following lining standard. 
9. Reinforcement pattern pieces are cut following upper piece pattern. 
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Learning Outcome 2.1 - Prepare Mean Form 

 
 

 

Contents: 

 

▪ Mean form 
▪ Mean form making process  

 

 

Assessment criteria: 

 

1. Mean form making process is identified and described. 
2. Last, pattern paper and masking tape are identified and selected. 
3. Mean form making is carried out as per job specification. 

 

 

Resources required: 

 

Students/trainees must be provided with the following resources: 

▪ Personal Protective Equipment (PPE): gloves, safety shoes, working clothes, apron 
▪ Tools and equipment: Measuring scale/tape, last, scissor, NT cutter 
▪ Materials: Masking tape, pattern paper 

 

   LEARNING ACTIVITY 2.1.1 

 

Learning Activity Resources/Special Instructions/References 

Preparing mean form ▪ Information Sheet: 2.1.1 

▪ Job Sheet 1 

▪ Self-Check: 2.1.1 

▪ Answer Key: 2.1.1 

https://www.youtube.com/watch?v=Y7nKo7booIE 

https://www.youtube.com/watch?v=O6_1eZkOM-E 

https://youtu.be/oOU45qd4RBQ 

 

 

 INFORMATION SHEET 2.1.1 

 

Learning Objective: to prepare mean form. 

Mean form 

The first step is to convert the 3D shape of the last into a flattened 2D shape which is usually called ‘Mean 
form’. Mean form is required to make a shoe standard according to design. 

https://www.youtube.com/watch?v=Y7nKo7booIE
https://www.youtube.com/watch?v=O6_1eZkOM-E
https://youtu.be/oOU45qd4RBQ
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When style lines and the lasting allowance are added into the 2D shape of the last, the form can be called 
‘Standard’. The patterns are cut out from this standard for cutting materials and stitched together to create 
the 3D footwear design. These steps are made for the typical sample size which is 42 EU for men’s and 37 
EU for women’s (or their equivalent for English size and USA size). 

Mean form making process  

1. Select the last. 

2. Cover the last both side by masking tape. 

3. Draw front and back centre line. 

4. Point out reference points like instep point, vamp, tip of toe, back height /counter point, maximum back 
curve. 

5. Cut outside and inside form as per front and back centre line. 

6. Remove both form from the last and cut along centre line mark. 

7. Replace form on last and check accuracy. 

8. Trace outside form all round and indicate all reference points. 

9. Place inside form outline all round matches with back height and tip of toe according outside form. 

10. Divided difference between inside and outside form line and mark to create mean form.  
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JOB SHEET 1 

Qualification:  Pattern making, grading and CAD CAM operation 

Learning unit: Prepare mean form 

Learner name:  

Personal protective 
equipment (PPE): 

 

Gloves, safety shoes, working clothes, apron 

Materials: Masking tape, pattern paper 

Tools and 
equipment: 

Last, scissor, NT cutter, measuring scale, pencil, eraser 

Performance criteria: 1. Mean form making process is identified and described. 

2. Last, pattern paper and masking tape are identified and selected. 

3. Mean form making is carried out as per job specification. 

Measurement: • Measurement to be taken perfectly 

• Carefully take the measurement of different reference point 

Notes: 

 

• Use NT cutter carefully. 

• Masking tape should be distributed and pasted properly. 

Drawing, Plan, 
Diagram or Sketch: 

 

Procedure: 1. Collect the selected last. 

2. Cover the last both sides crosswise by masking tape. 

3. Draw front and back centre line.  

4. Point out reference points like instep point, vamp, tip of toe, back 
height/counter point, maximum back curve. 

5. Cut outside and inside form as per front and back centre line. 

6. Remove both form from the last and cut along centre line mark. 

7. Replace form on last and check accuracy. 

8. Trace outside form all round and indicate all reference points. 

9. Place inside form outline all round matches with back height and tip of toe 
according outside form. 

10. Divide difference between inside and outside form line and mark to create 
mean form. 

Learner signature:  Date:  
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Assessor signature:  Date:  

Quality Assurer 
signature: 

 Date:  

Assessor remarks: 

 

 

 

Feedback: 

 

 

 

 

 

SELF-CHECK QUIZ 2.1.1 

 

Write the correct answer for the following questions. 

1. What is mean form? 

2. Why is mean form needed for standard making? 

3. What do you understand by standard? 

4. How do you make a mean form from a given last? 
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Learning Outcome 2.2 - Develop Standard/Shell 

 
 

 

Contents: 

 

▪ Types of standard/shell  
▪ Upper standard/shell making 
▪ Lining standard/shell making 

 

 

Assessment criteria: 

 
 
1. Types of standard/shell are identified. 
2. Upper standard/shell making is performed. 
3. Lining standard/shell making is carried out. 

 

 

Resources required: 

 

Students/trainees must be provided with the following resources: 

▪ Personal Protective Equipment (PPE): gloves, safety shoes, working clothes, apron 
▪ Tools and equipment: NT cutter, measuring scale/tape, scissors 
▪ Materials: Masking tape, pattern paper, pencil, eraser 

 

 

LEARNING ACTIVITY 2.2.1 

 

Learning Activity Resources/Special Instructions/References 

Developing standard/shell ▪ Information Sheet: 2.2.1 

▪ Job Sheet 2 

▪ Self-Check Quiz: 2.2.1 

▪ Answer Key: 2.2.1 

https://www.youtube.com/watch?v=fzPMeVtymoY 

 

 

INFORMATION SHEET 2.2.1 

 

Learning Objective: to develop standard/shell. 

Standard /Shell 

Standard /shell is the representation basic style of shoe into two-dimension form with all necessary style 
line and lasting allowance.  

https://www.youtube.com/watch?v=fzPMeVtymoY
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Types of standard/shell  

(a) Upper standard/shell 

(b) Lining standard/shell 

 
 
 
 
 
 
 
 
 
Upper standard/shell making for oxford shoe: 

 

Figure of a standard of oxford shoe 

 
1. Trace the mean form on pattern paper 

2. Mark the inside line 

3. Draw the parts/components of footwear according to design selected 

4. Add the required allowances/margin to the components. 

5. Add lasting margin to feather line of each component. 

Mark the following points on the outline of the mean form in order to create an upper standard/shell: 
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Draw a straight-line connecting Q and A and extend it to meet a perpendicular line dropped down from T. 
Design the quarter curve from T, through A all the way to Q as shown. Add an allowance for a heel stiffener 
by marking a point 3/16″ out from S and connecting it with C using a curve that roughly mimics the heel 
curve as drawn. Continue this line from C to a point marked 1/16″ inside of Q; this will tighten up the top 
line of the upper. 

Lining standard/shell making for oxford shoes: 

1.  Trace the prepared upper standard on pattern paper along with lasting margin. 

2.  Transfer all reference points from standard to pattern paper. 

3.  Reduce 3mm from toe point to create a pocket for insertion of toe puff. Cut the point from vamp point. 

4.  Reduce 2mm from back height point (to make a tight topline) and 4mm from seat point to create a 
pocket for insertion of counter stiffener. Match the reduced point creating a curve line like upper 
standard. 

5.  Reduce 6mm along the lasting margin to facilitate lining materials make bond with insole. 

 

This will involve using the upper 
standard/shell pattern and marking out 
the parts of the lining such that none of 
the seams in upper pattern overlap the 
seams in lining, which would cause 
unsightly and uncomfortable bulk in the 
shoe. 
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JOB SHEET 2 

Qualification:  Pattern making, grading and CAD CAM operation 

Learning unit: Develop upper standard/shell 

Learner name:  

Personal protective 
equipment (PPE): 

 

Gloves, safety shoes, working clothes, apron 

Materials: Masking tape, pattern paper 

Tools and equipment: Scissor, NT cutter 

Performance criteria: 1. Types of standard/shell are identified. 

2. Upper standard/shell making is performed. 

3. Lining standard/shell making is carried out. 

Drawing, Plan, 
Diagram or Sketch: 

 

Measurement: • Measurement to be taken perfectly 

• Carefully take the measurement of different reference point   

Notes: 

 

• Use NT cutter carefully. 

• Open all slots properly. 

Procedure: 1. Trace the mean form on pattern paper. 
2. Mark the inside line. 
3. Draw the parts/components of footwear according to design selected. 
4. Add the required allowances/margin to the components. 
5. Add lasting margin to feather line of each component. 

Learner signature: 
 Date:  

Assessor signature: 
 Date:  
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Quality Assurer 
signature: 

 Date:  

Assessor remarks:  

 

 

Feedback:  

 

 

 

 

SELF-CHECK QUIZ 2.2.1 

 

Write the correct answer for the following questions. 

1. What is shell or standard?  

2. What are the types of shell? 

3. How to prepare a classic oxford/derby shell? 

4. How to make a lining shell from upper standard? 
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Learning Outcome 2.3 - Cut Pattern from Standard/Shell 

 

 

 

Contents: 

 

▪ Upper piece patterns 
▪ Lining piece patterns  
▪ Reinforcement pattern pieces 

 

 

 Assessment criteria: 

 
 
1. Upper piece patterns are cut following upper standard. 
2. Lining piece patterns are cut following lining standard. 
3. Reinforcement pattern pieces are cut following upper piece pattern. 

 

 

Resources required: 

 

Students/trainees must be provided with the following resources: 

▪ Personal Protective Equipment (PPE): Gloves, safety shoes, working clothes, apron. 
▪ Tools and equipment: Scissor, NT cutter 

 

 

LEARNING ACTIVITY 2.3.1 

 

Learning Activity Resources/Special Instructions/References 

Cutting pattern from standard/shell ▪ Information Sheet: 2.3.1 

▪ Self-Check Quiz: 2.3.1 

▪ Answer Key: 2.3.1 

 

 

INFORMATION SHEET 2.3.1 

 

Learning Objective: to cut pattern from standard/shell. 

Upper piece patterns/sectional pattern 

Upper piece patterns/sectional pattern is individual part of shoe with all necessary allowance.  
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Cutting of upper piece patterns (manually) 

Cutting of vamp piece pattern: 

1.  Take a piece of pattern paper a bit bigger than the vamp component. Mark and partially cut a straight 
line at the middle of paper piece. Then fold it on partial cut line. 

2.  Put the standard on the folded line and mark on the folded paper according to the area of vamp. 

3.  Take away the standard and mark clearly the transferred line and add allowances like folding, seam, 
underlay, lasting, etc. according to the design specification. 

4.  Cut vamp pattern according marked line. 

5.  Cut a notch at the inside of vamp pattern.  

6.  Write the name of component and other information on the pattern. 

Cutting of quarter piece pattern: 

1.  Take a sizable piece of pattern paper.  

2.  Put the standard on the paper and mark (eyelet hole position, derby lock position, etc.) on the paper 
according to the area of quarter. 

3.  Take away the standard and mark clearly the transferred line and add allowances like folding, seam, 
underlay, lasting, etc. according to the design specification. 

4.  Cut quarter pattern according marked line. 

5.  Cut a notch at the inside of quarter pattern (if any).  

6.  Write the name of component and other information on the pattern. 

Cutting of counter piece pattern: 

1.  Take a sizable piece of pattern paper. Mark and partially cut a straight line at the middle of paper 
piece. Then fold it on partial cut line. 

2.  Put the standard on the folded line and mark on the folded paper according to the area of vamp. 
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3.  Take away the standard and mark clearly the transferred line and add allowances like folding, seam, 
lasting, etc. according to the design specification. 

4.  Cut counter pattern according marked line. 

5.  Write the name of component and other information on the pattern. 

Mark off the locations of the individual parts of 
the shoe pattern; i.e. the toe cap, vamp, 
quarters, tongue, and back strip following all 
measurements as bellow: 
 
 
 
 
 
 
 
 

 
Vamp: 

• F = 1/2″ below E 

• Draw a straight-line connecting F and V 

• <FVJ is 90° 

• VO = 1/3 VJ + 1/16″    

• OM = 1″ (parallel to line EV) 

• Connect points V and M and extend the line to the 
edge of the standard, which indicates point X. 

Now design the vamp curve from V’ (1/8″ above V) 
through M to X as shown. Add an extra 3/16″ along the 
vamp curve for folding (beading) if desired. This is the 
process of skiving down and folding over the edges of 
each piece before assembling shoe so that no raw 
edges will be exposed in the final product. 
 
Toe Cap: 

• EG = 1/2″ 

• VP = 1/3 VG 

• Starting at point P, the toe cap follows the curve of a circle with a 12″ 
radius (whose centre point would be in a straight line with PE)  

 
 
 
 
 
 

 
 

Quarter: 
The quarter is already formed. The only modification that 
you should make to your pattern is to extend it by 3/8″ along 
the vamp line so that the pieces can overlap when you 
assemble them later. (Add 3/16″ along the facings and 
throat for beading if desired.) 
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Back Strip: 
Fold a piece of paper in half and cut the strip to the following measurements: 

• Length = Back of quarter + 3/8″ 

• Width (from the fold) = 

• 3/8″ at the top 

• 5/16″ at the middle 

• 5/8″ at the bottom 

Then cut out and unfold. 
 
 

Tongue: 

• Length = Same as line VT (1/4 SL + 1/4″) 

• Width (from the fold) = 

• 1   1/8″ at the top 

• 3/4″ at the bottom 

Then cut out and unfold 

 

 

Lining piece patterns and reinforcement pattern pieces are also cut in the same way as the upper piece 
pattern cut and prepared. 

Cutting of vamp Lining 
 
-  V' is 3/8"to the right of the V (the vamp point)  
-  Extend an arc down from V' whose diameter is EV'- 

stopping 1/8"above line RY  
-  Y' is 3/8"to the right of Y  

-  From Y' extend a curve upwards that follows 
the curvature of line RY- stopping when you 
hit the arc down in step 2  

- The forepart and bottom of the lining pattern 
will be like that of the upper- tress a line from 
V' to E to Y'. 

 
 
 
 
 
 
 

Quarter and heel lining: 
- Extend the line OM to the left, doubling its length. 
- R is the point on the vamp line 3/16" above the extended line OM. 
- Line RK follows the curvature of the vamp line and extends above the original quarter pattern by 1/4". 
- Measure 1/8" left of Q (the top of the heel) and mark it.  
- Measure 1/4" left of S (the seat of the heel) and mark it.  
- Following the curvature of the heel, draw a line connecting the two marks that you just made and extend 

it above the original quarter pattern by 1/4"- mark Q' at the top of this line.  
- Line KQ' lies above the original quarter pattern, following its curvature.  
- Y is to the right of X. 
- Draw the line RY as shown above.  
- Z is the halfway between Y and S. 
- Angle SZF is 90º. 

https://lordpoint.files.wordpress.com/2016/02/lining-pattern-pieces.jpg
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SELF-CHECK QUIZ 2.3.1 

 
 
Write the correct answer for the following questions. 

1. How to cut a VAMP piece pattern from a DERBY shell?  

2. How do you make quarter pattern from given shell? 

3. Write the cutting of a counter pattern from given shell. 
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ANSWER KEYS 

 

 

ANSWER KEY 2.1.1 

1. Mean form: the first step is to convert the 3D shape of the last into a flattened 2D shape which is usually 

called ‘Mean form’. 

2. Mean form is required to make a shoe standard according to design. 

3. When style lines and the lasting allowance are added into the 2D shape of the last, the form can be 

called ‘Standard’. 

4. Mean form making process: 

(a) Select the last. 

(b) Cover the last both side by masking tape. 

(c) Draw front and back centre line. 

(d) Point out reference points like instep point, vamp, tip of toe, back height /counter point, maximum 
back curve. 

(e) Cut outside and inside form as per front and back centre line. 

(f) Remove both form from the last and cut along centre line mark. 

(g) Replace form on last and check accuracy. 

(h) Trace outside form all round and indicate all reference points. 

(i) Place inside form outline all round matches with back height and tip of toe according outside form. 

(j) Divided difference between inside and outside form line and mark to create mean form.  

ANSWER KEY 2.2.1 

1. Shell or standard: standard /shell is the representation basic style of shoe into two-dimension form with 

all necessary style line and lasting allowance.  

2. Type of shell: 

(a) Upper standard/shell 

(b) Lining standard/shell 

3. Preparing a classic oxford shell: 

1. Trace the mean form on pattern paper 

2. Mark the inside line 

3. Draw the parts/components of footwear according to design selected 

4. Add the required allowances/margin to the components. 

5. Add lasting margin to feather line of each component. 

4. Making a lining shell from upper standard: 

1.  Trace the prepared upper standard on pattern paper along with lasting margin. 

2.  Transfer all reference points from standard to pattern paper. 

3.  Reduce 3mm from toe point to create a pocket for insertion of toe puff. Cut the point from vamp 
point. 

4.  Reduce 2mm from back height point (to make a tight topline) and 4mm from seat point to create 
a pocket for insertion of counter stiffener. Match the reduced point creating a curve line like upper 
standard. 
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5.  Reduce 6mm along the lasting margin to facilitate lining materials make bond with insole. 

ANSWER KEY 2.3.1 

1.  Cutting of vamp piece pattern: 

1.  Take a piece of pattern paper a bit bigger than the vamp component. Mark and partially cut a 
straight line at the middle of paper piece. Then fold it on partial cut line. 

2.  Put the standard on the folded line and mark on the folded paper according to the area of vamp. 

3.  Take away the standard and mark clearly the transferred line and add allowances like folding, 
seam, underlay, lasting, etc. according to the design specification. 

4.  Cut vamp pattern according marked line. 

5.  Cut a notch at the inside of vamp pattern.  

6.  Write the name of component and other information on the pattern. 

2.  Cutting of quarter piece pattern: 

1.  Take a sizable piece of pattern paper.  

2.  Put the standard on the paper and mark (eyelet hole position, derby lock position, etc.) on the 
paper according to the area of quarter. 

3.  Take away the standard and mark clearly the transferred line and add allowances like folding, 
seam, underlay, lasting, etc. according to the design specification. 

4.  Cut quarter pattern according marked line. 

5.  Cut a notch at the inside of quarter pattern (if any).  

6.  Write the name of component and other information on the pattern. 

3.  Cutting of counter piece pattern: 

1.  Take a sizable piece of pattern paper. Mark and partially cut a straight line at the middle of paper 
piece. Then fold it on partial cut line. 

2.  Put the standard on the folded line and mark on the folded paper according to the area of vamp. 

3.  Take away the standard and mark clearly the transferred line and add allowances like folding, 
seam, lasting, etc. according to the design specification. 

4.  Cut counter pattern according marked line. 

5.  Write the name of component and other information on the pattern. 
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Module 3: Prepare standard/shell using 3D software 

 

 

MODULE CONTENT 

 

Module Descriptor: This module covers the skills, knowledge and attitudes to prepare a standard/shell 
using 3D software. The module covers the tasks of digitising last and developing a standard/shell. It also 
includes information sheets, job sheets, self-checking, answer keys and assessment plan. 

 

Nominal Duration: 64 hours 

 

 

LEARNING OUTCOMES:  

 

Upon completion of the module, the student/trainee should be able to: 

3.1. Digitise last 
3.2. Develop a standard/shell 

 

 

                      PERFORMANCE CRITERIA: 

 

 

1. A hole on back centre line curve point is made by drill machine as per pin diameter. 
2. The last is placed on 3D scanning chamber by means of pin hole. 
3. The parameter for scanning is set. 
4. Digitising is carried out. 
5. Scanned last is converted to 3D last (e-last). 
6. 3D last (e-last) is imported/ opened. 
7. The last reference points are selected. 
8. The guidelines are selected and followed. 
9. The style lines are drawn and the standard/shell on 3D last (e-last) is completed. 
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Learning Outcome 3.1 - Digitise Last 

 

 

 

Contents: 

 

▪ Parameter for scanning 

 

 

Assessment criteria: 

 
 
1. A hole on back centre line curve point is made by drill machine as per pin diameter. 
2. The last is placed on 3D scanning chamber by means of pin hole. 
3. The parameter for scanning is set. 
4. Digitising is carried out. 
5. Scanned last is converted to 3D last (e-last). 

 

 

Resources required: 

 

Students/trainees must be provided with the following resources: 

▪ Personal Protective Equipment (PPE): Safety shoes, working clothes, apron 
▪ Tools and equipment: Lasts, digitiser 

 

 

   LEARNING ACTIVITY 3.1.1 

 

Learning Activity Resources/Special Instructions/References 

Digitising last ▪ Information Sheet: 3.1.1 

▪ Self-Check: 3.1.1 

▪ Answer Key: 3.1.1 

▪ Group Activity 

https://www.youtube.com/results?search_query=scanny+3d 

 

 

 INFORMATION SHEET 3.1.1 

 

Learning Objective: to digitise last. 

Digitization is the process of converting information into a digital format. In this format, information is 
organized into discrete units of data (called bites) that can be separately addressed.  

 

https://www.youtube.com/results?search_query=scanny+3d
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Parameter for scanning: 

❖ Scanning zone- in default 
there will be three zones. 
back, mid and toe 

❖ Number of scan line per 
zone- in back and toe 1.5-2 
mm/line in mid 3-3.5 mm/line 

❖ Number of points per zone in 
back and toe 250-300, in mid 
200-250 

❖ Percentage of sensitivity 30-
40% for normal last and 40-
60% for high heel and boot 
last. 

Position of last inside the scanner: 
The last should be placed in such a position that it should be well balanced and erect position and the 
surface of the last ahead of the rotation axis for about 2 millimetres or more.  
 

 

Procedure: 

1)  Take care to the direction of the hole practiced in the heel of the last. During the implantation of the 
shape inside of the scanner to regulate the position of the shape through support SN01 in order to 
place the surface of the shape ahead of the rotation axis for about 2 millimetres or more. 

2)  In the software SCANNY3D generate the preview image with the last in lateral sight: the image 
visualizes the last and the rotation axis therefore it allows to establish (in an approximate way) if the 
position of the last is right or not. 
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3)  Set-up the scanning parameters and take attention to activate the option “out-axis” in the top portion 
of the last to acquire. 

Digitize 3D last: 

1. Make a hole on back centre line curve point of last by drill machine as 
per pin diameter. 

2. Place the last on 3D scanning chamber by means of pin hole. 

3. Set the parameter for scanning. 

4. Carryout digitising. 

 

 

 

 

 

 

 

 

 

SELF-CHECK QUIZ 3.1.1 

 
 
Write the correct answer for the following questions: 

1. What is digitization? 

2. How to make hole on last? 

3. How to place the last on scanny3D? 

4. How do you digitize a 3D last? 
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Learning Outcome 3.2 - Develop a Standard/Shell 

 
 

 

Contents: 

 

▪ Style lines 

 

 

Assessment criteria: 

 

1. 3D last (e-last) is imported/opened. 

2. The last reference points are selected. 

3. The guidelines are selected and followed. 

4. The style lines are drawn and the standard/shell on 3D last (e-last) is completed. 

 

 

Resources required: 

 

 
Students/trainees must be provided with the following resources: 

▪ Personal protective equipment (PPE): gloves, safety shoes, working clothes, apron 

▪ Tools and equipment: 3D last (e-last), 3D CAD software 

 

  

LEARNING ACTIVITY 3.2.1 

 

Learning Activity Resources/Special Instructions/References 

Developing a standard/shell ▪ Information Sheet: 3.2.1 

▪ Self-Check Quiz: 3.2.1 

▪ Answer Key: 3.2.1 

 

 

 INFORMATION SHEET 3.2.1 

 

Learning Objective: to develop a standard/shell. 

Style lines: 

− Top line 

− Quarter line 

− Vamp line 
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− Counter line 

− Mudguard line 

− Tongue line 

− Toe cap line 

− Back strap line 

Development of a standard/Shell: 

1. Import/open the 3D last (e-last). 

2. Select the last reference points. 

3. Select and follow the guidelines. 

4. Draw the style lines and complete the standard/shell on 3D last (e-last). 

 

 

SELF-CHECK QUIZ 3.2.1 

 

Write the appropriate/correct answer of the following: 

1. Name five reference points of a shoe? 

2. Name the different types of style lines. 

3. How to develop a standard/shell from e-last? 
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ANSWER KEYS 

 

 

ANSWER KEY 3.1.1 

1. Digitization is the process of converting information into a digital format. 

2. A hole on back centre line curve point of last is made by drill machine as per pin diameter 

3. The last is placed on 3D scanning chamber by means of the pin hole. 

4. Digitizing a 3D last: 

(a) Make a hole on back centre line curve point of last by drill machine as per pin diameter. 

(b) Place the last on 3D scanning chamber by means of pin hole. 

(c) Set the parameter for scanning. 

(d) Carryout digitising. 

ANSWER KEY 3.2.1 

1.  Reference points of shoe: 

(a) Vamp point 

(b) Back height point 

(c) Instep point 

(d) Seat point 

(e) Ball point 

2.  Names of style lines: 

− Top line, quarter line, vamp line, counter line, mudguard line, tongue line, toe cap line and back 
strap line. 

3.  Development of a standard/shell: 

1. Import/open the 3D last (e-last). 

2. Select the last reference points. 

3. Select and follow the guidelines. 

4. Draw the style lines and complete the standard/shell on 3D last (e-last). 
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Module 4: Perform computer-aided pattern making operation using 2D software 

 

 

MODULE CONTENT 

 

Module Descriptor: This module covers the skills, knowledge and attitudes to perform computer-aided 
pattern making operation using 2D software. The module covers the tasks of digitising 2D standard/shell, 
creating new style lines and cutting piece pattern. It also includes information sheets, job sheets, self-
checking, answer keys and assessment plan. 

 

Nominal Duration: 16 hours 

 

 

LEARNING OUTCOMES:  

 

Upon completion of the module, the student/trainee should be able to: 

4.1. Digitise 2D standard/shell 
4.2. Create new style lines 
4.3. Cut piece patterns 

 

 

 

                      PERFORMANCE CRITERIA: 

 

1. Standard/shell is developed and prepared for digitising, either manually or by 3D software. 
2. Digitizing tablet is initialised. 
3. Simple and advanced style lines are digitised. 
4. New style lines are created. 
5. Duplicate line is created. 
6. New offset line is made. 
7. Tied offset line is prepared. 
8. Mirror line and tied mirror line is created. 
9. Line modification is carried out. 
10. Working sequence of CAD-CAM is identified. 
11. Punches are created and saved. 
12. New piece is created. 
13. Pattern engineering is carried out. 
14. Final piece pattern making is completed. 
15. Piece pattern is cut using CAM. 
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Learning Outcome 4.1 - Digitise 2D Standard/Shell 

 

 

 

Contents: 

 

▪ Digitising tablet 
▪ Style lines 

 

 

Assessment criteria: 

 

1. Standard/shell is developed and prepared for digitising, either manually or by 3D software. 
2. Digitizing tablet is initialised. 
3. Simple and advanced style lines are digitised. 

 

 

Resources required: 

 

Students/trainees must be provided with the following resources: 

▪ Personal Protective Equipment (PPE): gloves, safety shoes, working clothes, apron 
▪ Tools and equipment: Digitiser 

 

 

   LEARNING ACTIVITY 4.1.1 

 

Learning Activity Resources/Special Instructions/References 

Digitising 2D standard/shell ▪ Information Sheet: 4.1.1 

▪ Self-Check: 4.1.1 

▪ Answer Key: 4.1.1 

https://www.youtube.com/watch?v=jvUQ_whKje0 

 

 

 INFORMATION SHEET 4.1.1 

 

Learning Objective: to digitise 2D standard/shell. 

Digitizing tablet: 

An input device that enables you to enter drawings and sketches into a computer. A digitizing tablet consists 
of an electronic tablet and a cursor or pen. Digitizing tablets are also called digitizers, graphics tablets, 
touch tablets, or simply tablets. The tablet is attached to the computer and the stylus to the tablet. The 
tablets capture the image as data which is then stored as a file or document. The tablet works by plugging 
into a computer via a USB port. 

https://www.youtube.com/watch?v=jvUQ_whKje0
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To install a digitizer for use with CAD: 

➢ Obtain the latest Wintab drivers for the digitizer. 

➢ Connect the digitizer to the serial port. 

➢ Turn on the digitizer. 

➢ Run Setup for the Wintab driver and follow the installation instructions. 

➢ Restart the computer.  

➢ Start the CAD and on the Tools menu, click Options. 

Advantages of digitizing tablet: 

❖ A benefit for graphics artists. 

❖ More effective than mouse input. 

❖ Can come in different sizes. 

❖ Natural to use for anyone familiar with a pen. 

❖ Can record levels of pressure unlike other point and click devices. 

Style lines: 

A style line is a line (or curve) in a garment that has a visual effect, e.g., the seam between two fabrics of 
different colours. For comparison, a nearly invisible seam (say, in a French dart) would not be considered 
a style line. A style line is a boundary between two distinguishable areas of fabric. 

Prepare a standard for digitizing 

Before you begin digitizing any new shell it is wise to take a 
few minutes to consider the best methods of working e.g. the 
most effective way of digitizing. Consider any factors affected 
by grading restrictions or holding required for production. A 
few minutes of preparation at this early stage might save you 
time in unnecessary modification later. 

The shell lines that you digitize represent the “flattened” shoe 
last that your style is developed on. Although you will be able 
to make modifications to these lines once digitized, you should 
aim to be as accurate as possible. 

2D Digitizer machine preparation: 

This set is given below: 

Tools > Digitizer > 2D > USB /Cal Comp VI 

Add a centre line 

The centre line is used to enter important reference points in the first stage of digitizing. 

1. Draw a line that extends the existing centre line to the edge of the style. 
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Add a Top Line 

The top line should only be a short line that extends 
from the edge of the top line out. From figure a-b. This 
line is usually positioned at the Back Height of the last 
and the line you draw should follow the shape of the top 
line of the design. 

1.  Draw a pencil line from Figure A: to Figure B to 
make a representation of the top line. 

Prepare the feather edges 

When you digitize you will be using a mouse to click 
around specific lines of the shell. The clicks you make 
will represent “nodes” that make up the Shoemaster 
line. The clicks you make will determine the shape of 
the finished line, so it is important that you digitize as accurately as possible. 

To help you, you can indicate the mouse clicks you intend to make on the design. Whilst this is not 
necessary in achieving an accurate representation of the shell, it is something we recommend. 

It is advisable that the clicks you make on the net and gross feather lines correspond, e.g. so they have 
the same number of nodes in the same positions. 

 

 

1.  Draw a pencil line from the net feather edge to the gross, as shown below. 

2.  Where the pencil line hits the feather edges, use this as a marker for your mouse clicks when digitizing. 

Initialize a digitizing tablet 

Use the following procedure to initialize the digitizing 
tablet and input two important points; including the net 
toe point which allows the user to return to the style at 
a later date. 

Use the following option in the Line menu to select the 
Initialize Tablet function. 

Line> New > Digitize > Shell >Initialize tablet  

1.  Position the 2D shell standard on your digitizing 
tablet. 

2.  Now select the function. 

3.  At the prompt “enter net toe point and one point 
along the centre line” click to enter the two 
required points, as shown in the example below. 
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This completes the Tablet Initialization and the tablet is now ready for digitizing. 

Digitize style lines 

Use this procedure to digitize style lines from 
the hand drawn standard into the 
Shoemaster system. 

1.  Use the following option in the Line menu 
to select the Digitize Style Line function: 

Line > New > Digitize > Shell > Style line  

2.  On selection of the function you are 
prompted to “Please enter points using 
digitizer” and should refer to the style on 
the digitizer. 

3.  You will now need to use the digitizer 
mouse to enter points that represent the 
style lines of the design. As before, every 
click you make represents a node on the 
style line and you should try not to use too 
many nodes as it will make modification 
more difficult later on. 

4.  Decide the first line you are going to digitize. 

5.  Now use the X-Y or 0 button on the mouse and click around the shape of the line. 

6.  When you have finished the line, you can select to accept button the line or 2 button, draw the line and 
New Line 2D. 

This will accept the line you have just digitized, draw it to the screen and put you back into the line 
digitization mode so you can carry straight on with the next line. 

 

7.  Repeat the process and use the XY button to click around the second line of your choice. 
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8.  When you have finished the line select to Accept the line, draw the line and New Line 2D. 

9.  Repeat these steps until have digitized all the required lines. 

10.  When you have entered the last line, use the Accept or 3 buttons on the mouse, Draw Line 2D, Disable 
Tablet button on the mouse to complete the process. 

 

 

 

SELF-CHECK QUIZ 4.1.1 

 

Write the correct answer for the following questions. 

1. How to connect the digitizer with CAD? 

2. How to prepare 2D Digitizer machine?  

3. What are the advantages of digitising tablets? 

4. How do you initialize Tablet function? 

5. How will you digitize style lines? 
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Learning Outcome 4.2 - Create New Style Lines 

 

 
 

Contents: 

 
 

• Line modification 

 

 

Assessment criteria: 

 
 

1. New style lines are created. 
2. Duplicate line is created. 
3. New offset line is made. 
4. Tied offset line is prepared. 
5. Mirror line and tied mirror line is created. 
6. Line modification is carried out. 

 
 

Resources required: 

 

 
Students/trainees must be provided with the following resources: 

▪ Personal Protective Equipment (PPE): gloves, safety shoes, working clothes, apron 
▪ Tools and equipment: CAD, 2D software 

 

  

LEARNING ACTIVITY 4.2.1 

 

Learning Activity Resources/Special Instructions/References 

Creating new style lines ▪ Information Sheet: 4.2.1 

▪ Self-Check Quiz: 4.2.1 

▪ Answer Key: 4.2.1 

https://www.youtube.com/watch?v=GhbGnMKeCSE 

 

 

 INFORMATION SHEET 4.2.1 

 

Learning Objective: to create new style lines. 

https://www.youtube.com/watch?v=GhbGnMKeCSE
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New Line 

Create brand new style lines using the 
New Line function found in the new 
section of the Line menu. 

Line > New > New line 

1.  On selection of the function you are 
prompted to "enter nodes for the line 
then accept or quit". 

2.  Click the left mouse button where 
you want to start the new line. 

3.  Move the mouse to shape the line, 
securing the shape with a click. 

 

 

 

 

 

 

 

 

 

 

 

 

 

4.  When you have made the final click and want to complete the process, Right Click the mouse to 
produce a cascade menu. See below for a description of the options in the menu. 

5.  Select Accept to complete the process and draw the line. 

New offset Line 

Create a new offset style lines using the Offset function found in 
the new section of the Line menu. 

Line > New > Offset  

1.  First select the line you want to make an offset from. 

2. Now select the function. 
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3. Enter the value for the offset in the dialog produced and 
click OK. 

4.  At the prompt "click on the side of the line to offset" click to 
indicate which side of the selected line you want the new 
offset line to appear. 

A new offset line is now created on the side of the selected line 
that you clicked. 

Tied offset Line 

Create a new tied offset line(s) using the Tied>Offset function 
found in the New section of the Line menu. 

This allows a new tied line to be created at an offset distance 
from the original line. 

Line > New > Tide > Offset  

1.  Select the lines you want to make a tied offset from. 

2.  Now select the function. 

3.  Enter the required offset distance in the dialog and click OK. 

4.  At the prompt "point to the side to offset the tied line" click on the side of the line you want to create 
the new tied offset. 

The new line is now added at the offset distance specified and on the side of the line you clicked. 

Please note this is a repeatable command. 

 

5.  Right click to quit the function. 

Any changes made to the original line will now reflect in the new tied offset line. 

Mirror Line 

Create a new mirror line(s) using the Mirror>Line function found in the New section of the Line menu. 

Line > New > Mirror > Line 

1.  Select the lines you want to mirror. 

2.  Now select the function. 

The lines you selected will now automatically duplicate and mirror across the centre line of the standard. 
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Average Line 

Create a new average line using the Average function found in the new section of the Line menu. This 
function allows you to add a new line centrally between two selected lines. 

Line > New > Average 

1.  Select the two lines that you want to place an average line between. 

 

 

2.  Now select the function. 

On selection a new average line is automatically added between the two previously selected lines. 

 

Line modification: 

Edit nodes: Switch the Edit Nodes function on or off with this function. 

Line > Modify > Nodes > Edits Nodes 

1.  Select the function from the menu to switch it on - a tick will be visible once the function is ON. 

Switching this function on displays the nodes of any selected style lines. The user can now make 
modifications to the nodes to change the shape of the line. 

 

2.  Simply re-select the function to switch it off - the tick will no longer be visible once switched OFF. 

Switching the function off no longer displays the nodes of any selected style lines and allows the user 
to make modifications to the line as a whole. 
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Move Nodes: 

Use this function to move the position of a node on a selected line, and therefore change the shape of a 
line. 

1.  Select the line you want to modify. 

2.  Hover the cursor over the node you want to move and see it change shape. 

 

3.  Now hold the left mouse button down while moving the mouse to move the position of the cursor. 

4.  Release the mouse button to secure the node in the required position. 

 

Add Nodes: 

Use this function to add extra nodes to the selected style line. This is useful if you do not have adequate 
nodes to achieve the desired line shape. 

1.  Select the line you want to modify. 

2.  Simply click on the area of the line you want to add a new node. 
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The cursor will appear as shown in the example above, and a new node will appear at the point you clicked. 
You can move the node whilst adding it by simply moving the mouse as you click down, releasing to add a 
new node in the required position. 

Delete Nodes: 

Use this function to delete any unwanted nodes from the selected line. 

1.  Select the line you want to modify. 

2.  Hold the Ctrl key down and move the mouse over the node you want to delete. You will see the cursor 
change to a X. 

 

3.  Now click the left mouse button on the node to delete it. 

Move Lines: 

1.  Select the line or lines you want to move. 

 

2.  Now place the cursor over the line until it changes shape. 
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3.  Now hold the left mouse button down and move the mouse to move the line 

4.  When you are happy with the position, release the mouse button to secure the line in the required 
position. 

Rotate Lines: 

1.  Select the line you want to rotate 

You will notice the line is surrounded by a series of coloured dots. The green line is used to rotate the 
line; the yellow dot allows you to change the point of rotation. 

 

2. Hover the mouse over the green dot until it changes to the rotation cursor. 

 

 

Smooth line: 

Smooth the selected line(s) by redistributing the nodes using the Smooth>Line function found in the Modify 
section of the Line menu. 
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1.  Select the line you want to smooth. 

2.  Now select the function. 

The line is automatically smoothed and as this is a repeatable command, you can continue clicking the 
left mouse button to continue smoothing the line as required. 

3.  Right click the mouse to quit the function. 

Offset Line: 

Offset and move the currently selected line(s) by a given value using the Offset Line function found in the 
Modify section of the Line menu. 

Line > Modify > Offset line. 

1.  First select the line(s) to offset. 

2.  Now select the function. 

3.  Enter the offset value in the dialog produced and select OK. 

 

4.  At the prompt "click on the side of the line to offset" click to indicate which side you want to offset the 
line. The selected line is now moved in the direction you clicked by the offset value entered in the dialog. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Split line: 

Split a line in two or (more places) to produce two or more 
separate lines using the Split function found in the 
Modify>Advanced section of the Line menu. 

1.  Select the line you want to split. 

2.  Now select the function. 

3.  At the prompt "select split point" click on the line to indicate 
where you want to split the line. 
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The line is now split at the selected point and has now become two separate lines. 

 

 

 

 

 

 

 

 

 

 

 

SELF-CHECK QUIZ 4.2.1 

 
 
Write the appropriate/correct answer of the following: 

1. How do you create a new line? 

2. How do you create an offset line? 

3. How do you tied offset line? 

4. How do you mirror the line? 

5. How will you rotate a line? 
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Learning Outcome 4.3 - Cut Piece Patterns 

 

 

 

Contents: 

 
 
▪ Piece pattern making 
▪ Pattern engineering 

 

 

Assessment criteria: 

 
 

1. Working sequence of CAD-CAM is identified. 
2. Punches are created and saved. 
3. New piece is created. 
4. Pattern engineering is carried out. 
5. Final piece pattern making is completed. 
6. Piece pattern is cut using CAM. 

 

 

Resources required: 

 

 
Students/trainees must be provided with the following resources: 

▪ Personal Protective Equipment (PPE): gloves, safety shoes, working clothes, apron 
▪ Tools and equipment: CAD, CAM 

 

  

LEARNING ACTIVITY 4.3.1 

 

Learning Activity Resources/Special Instructions/References 

Cutting piece patterns ▪ Information Sheet: 4.3.1 

▪ Job Sheet 3 

▪ Self-Check Quiz: 4.3.1 

▪ Answer Key: 4.3.1 

https://www.youtube.com/watch?v=GhbGnMKeCSE 

 

 

 INFORMATION SHEET 4.3.1 

 

Learning Objective: to cut piece patterns. 

https://www.youtube.com/watch?v=GhbGnMKeCSE


CBLM – Pattern Making, Grading and CAD-CAM Operation (Student Guide) v.1 Mar 2018    65 

Skills for Employment Investment Programme (SEIP) 

 

Piece pattern making: 

Create a new piece: Create a new piece using the New 
Piece function found in the new section of the Piece menu. 

Pieces are created from the style lines you have either 
generated or digitized and will be stored either within an 
existing and currently selected Packet, or in the default 
packet that will be generated if there is no current packet. 

1.  Since pieces are created from style lines you will need 
to load a style (2D or 3D) into the program. 

 

 

 

 

 

 

 

2.  Now select the function. 

3.  On selection the Piece Name dialog is produced, and you will need to enter a name for the new piece. 

 

4.  When you have entered the required piece name, click OK to proceed. 

5.  You will now need to refer to the style and, with the pattern piece you want to create in mind, click on 
the style lines that will make up the pattern piece. For example, to create this pattern: 

 

It will need to click on the following style lines in order and in a CLOCKWISE direction to generate the 
piece: 

6.  When all the lines have been selected, right click to 
produce a menu. 

7.  To complete the piece, you can now select "Complete 
& Accept", or to complete the piece and continue 
straight to the next piece select "Complete, Accept & 
New Piece". 

8.  Complete this procedure as many times as necessary to make the required patterns. 

All patterns created can be conveniently viewed by switching on the Browser Window or alternatively you 
can view the Packet and pieces contained within the packet using the Style View window. 
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Add text to pieces: 

Add text to the selected piece(s) using the New Piece Text function found in the new section of the Piece 
menu. 

Piece > New > New piece text  

1.  Select the pieces you want to add text to. 

2.  Now select the function to produce the Build Text 
dialog. 

3.  Double click on the text you want to add from the list 
in the right-hand window. It should now appear in 
the left-hand window. 

4.  Click OK to confirm the required text and add it to 
the centre of the selected pattern. 

 

Pattern Engineering: 

Create a default marker 

Create a default marker on a pattern piece using a style line as a point of reference, using the Default 
option found in the Markers from Lines section of the Arc>New menu. 

1.  First select the piece you want 
to add a marker to. 

2.  Now select the line that you 
want to use as a reference for 
the new marker. 

3.  Now select the function from 
the menu. 

A default marker is automatically 
added to the pattern piece in the 
place of the selected style line. 

You can now use functions found in the Detail menu to help modify the marker line, such as applying 
breaks in the line to prevent the pattern piece from collapsing. 

Create an "as line" marker 

Create a marker on a pattern piece 
in the same format as the selected 
style line (for example, punch line or 
holes etc.) using the As Line option 
found in the Markers from Lines 
section of the Arc > New menu. 
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1.  First select the piece you want to add a 
marker to. 

2.  Now select the line that you want to use 
as a reference for the new marker. 

3.  Now select the function from the menu. 

A marker is automatically added to the 
pattern piece in the same form as the 
selected style line. 

 

 

 

 

 

 

 

 

Add a Part Line marker: 

Create a Part Line marker on a pattern piece using the existing nodes of a style line as a point of reference, 
using the Part Line option found in the Markers from Lines section of the Arc>New menu. 

1.  First select the piece you want to 
add a marker to. 

2.  Now select the line that you want 
to use as a reference for the new 
marker. 

3.  Now select the function from the 
menu. 

4.  On selection, the nodes that make 
up the lines are revealed, and you 
will need to select the nodes that 
you want to use as the start and 
end points of the part line marker. 

 

 

A part line marker is now added in the position of the selected nodes of the style line. 
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Add a cut: 

Create a cut in a pattern piece using a style line or lines as a point of reference, using the Cut option found 
in the Markers from Lines section of the Arc>New menu. 

The cut option is used when continuous and joined lines (or a shape etc) need to be added inside of the 
pattern. 

1.  First select the piece you want to add a cut to. 

2.  Now select the lines that you want to use as a reference for the new marker. 

 

3.  Now select the function from the menu. 

A cut is automatically added to the pattern piece in the place of the selected style lines. 

 

Add a slot: 

Create a slot in a pattern piece using a style line or lines as a point of reference, using the Slot option found 
in the Markers from Lines section of the Arc>New menu. 
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The slot option is normally used when single lines need to be cut inside of, or on the edge of the piece. 

1.  First select the piece you want to 
add a cut to 

2.  Now select the line(s) that you 
want to use as a reference for the 
new marker. 

3.  Now select the function from the 
menu. 

A slot is automatically added to the 
pattern piece in the place of the 
selected style line(s). 

 

 

Add allowances: 

This module shows you how to add various allowances to the arcs of your pieces, for production purposes. 
You will learn how to complete the basic function, which applies to all of the allowance options available. 

Each allowance options add a specific value to the arc(s) you have selected, suitable for the following: 

a. Seam allowance 

b. Fold allowance 

c. Lap allowance 

d. Shear allowance 

1.  Select the pattern piece that you want to add 
allowances to. 

2.  Now select the relevant arc or arcs. 

3.  Use the Arc drop down menu. 

4.  Select Modify. 

5.  Select Allowance. 

6.  Select the required allowance from the list. 

Add a lap marker 

This function enables you to add a lap allowance and marker simultaneously. 

1.  Select and draw the pattern that you want to add 
the marker to. 

2.  Now select the arc that you want to add the lap 
marker to. 

3.  Use the Arc drop down menu. 

4.  Select New. 

5.  Select Markers from Arcs. 

6.  Now select Lap. 
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Add a Centre Detail: 

This function enables you to add a detail specifically in the centre of an arc. 

1.  Select and draw the pattern piece that you want to add a detail to. 

2.  Use the Detail drop down menu. 

3.  Select New. 

4.  Select Advanced 

5.  Select Centre. 

6.  Now select the detail you want to add. 

7.  You are now prompted to "point to the centre notch position" and should click on the arc that you want 
to add the centre detail to. 

 

A centre detail is now added according to the click you make. 

Add an intersecting detail 

An intersecting notch/detail is useful to add for use when positioning pieces together in production. 

1.  Draw the style on screen and select the pattern you want 
to add an intersecting notch to. 

2.  Use the Detail drop down menu. 

3.  Select New. 

4.  Select Intersecting. 

5.  Now select Notch. 

6.  You are now prompted to "select the arc" and should click 
on the arc that you want to add the intersecting notch. 

7.  You are now prompted to "select the intersection line" 
and should click on the line that intersects the arc e.g. the 
line you want the notch to represent. 

A new notch is now added on the arc you selected, at the point where the style line intersects the arc. 

Piece Modification: 
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Swap lines used in a piece 

Change which line is used by an arc using the Swap Line function found in the Modify section of the Arc 
menu. 

1.  Select the piece to modify and 
then the arc that you want 
change. 

2:  Now select the function 

3:  You are now prompted to "point 
to the line to be used" and can 
click on the style line that you 
would like to be used in the 
piece. 

The usage of line is now changed 
from the original to the newly 
selected line. The piece will 
automatically reflect the changes. 

 

Pattern engineering 

1. Allowance (lasting, 
setting/underlay/lap, folding, 
seam, trimming). 

2. Punch (eyelet punch, decorative 
punch, branding of shoe). 

3. Marking (setting, stitch marking, 
in/out mark, notch mark, centre 
mark, chamfer cut for setting on 
folding). 

4. Text (size, piece name, style 
name, article name, date, design 
name). 
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JOB SHEET 3 

Qualification:  Pattern Making, grading and CAD CAM operation 

Learning unit: Perform pattern making using 2D software 

Learner name:  

Personal protective 
equipment (PPE): 

 

Gloves, safety shoes, working clothes, apron  

Materials: 
 

Tools and 
equipment: 

CAD-CAM 

Performance criteria: 1. Standard/shell is developed and prepared for digitising, either manually 
or by 3D software. 

2. Digitizing tablet is initialised. 

3. Simple and advanced style lines are digitised. 

4. New style lines are created. 

5. Duplicate line is created. 

6. New offset line is made. 

7. Tied offset line is prepared. 

8. Mirror line and tied mirror line is created. 

9. Line modification is carried out. 

10. Working sequence of CAD-CAM is identified. 

11. Punches are created and saved. 

12. New piece is created. 

13. Pattern engineering is carried out. 

14. Final piece pattern making is completed. 

15. Piece pattern is cut using CAM. 

Drawing, Plan, 
Diagram or Sketch: 

 

Measurement: • Measurement to be taken perfectly 

• The measurement of different reference point should be taken carefully 

Notes: 

 

• Use NT cutter carefully. 

• Masking tape should be distributed properly. 

Procedure: 1. Prepare standard/shell for digitising (Shell is developed either manually 
or by 3D software). 

2. Initialise digitizing tablet. 

3. Digitise simple and advanced style lines. 

4. Create new style lines. 

5. Create duplicate line. 
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6. Make new offset line. 

7. Prepare tied offset line. 

8. Create mirror line and tied mirror line. 

9. Carry out line modification. 

10. Create and save punches. 

11. Create new piece. 

12. Carry out pattern engineering. 

13. Complete final piece pattern making. 

14. Cut Piece pattern using CAM. 

Learner signature:  Date:  

Assessor signature:  Date:  

Quality Assurer 
signature: 

 Date:  

Assessor remarks: 
 

Feedback: 
 

 

 

SELF-CHECK QUIZ 4.3.1 

 

Write the appropriate/correct answer of the following: 

1. How to create a new piece pattern by using shoe master? 

2. How do you add text to pieces? 

3. How do you create a default marker? 

4. How do you add allowances? 

5. How to swap lines in a piece? 
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ANSWER KEYS 

 

 

ANSWER KEY 4.1.1 

1. To install a digitizer for use with CAD: 

➢ Obtain the latest Wintab drivers for the digitizer. 

➢ Connect the digitizer to the serial port. 

➢ Turn on the digitizer. 

➢ Run Setup for the Wintab driver and follow the installation instructions. 

➢ Restart the computer.  

➢ Start the CAD and on the Tools menu, click Options. 

2. Preparing 2D Digitizer machine:  

Tools > Digitizer > 2D > USB /Cal Comp VI 

3. Advantages of digitising tablets: 

❖ A benefit for graphics artists 

❖ More effective than mouse input 

❖ Can come in different sizes 

❖ Natural to use for anyone familiar with a pen 

❖ Can record levels of pressure unlike other point and click devices 

4. Initializing Tablet function: 

 Using the following option in the Line menu to select the initialize tablet function- 

 Line> New > Digitize > Shell >Initialize tablet  

5. Digitize style lines: 

 Using the following option in the Line menu to select the digitize style line function: 
 Line > New > Digitize > Shell > Style line  

ANSWER KEY 4.2.1 

1.  New Line 

Create brand new style lines using the New Line function found in the new section of the Line menu. 

Line > New > New line 

1.  On selection of the function you are prompted to "enter nodes for the line then accept or quit". 

2.  Click the left mouse button where you want to start the new line. 

3.  Move the mouse to shape the line, securing the shape with a click. 

4.  When you have made the final click and want to complete the process, Right Click the mouse to 
produce a cascade menu. See below for a description of the options in the menu. 

5.  Select Accept to complete the process and draw the line. 

2.  New offset Line 

Create a new offset style lines using the Offset function found in the new section of the Line menu. 

Line > New > Offset  

1.  First select the line you want to make an offset from. 

2.  Now select the function. 
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3.  Enter the value for the offset in the dialog produced and click OK. 

4.  At the prompt "click on the side of the line to offset" click to indicate which side of the selected line 
you want the new offset line to appear. 

A new offset line is now created on the side of the selected line that you clicked. 

3.  Tied offset Line 

Create a new tied offset line(s) using the Tied>Offset function found in the New section of the Line 
menu. 

This allows a new tied line to be created at an offset distance from the original line. 

Line > New > Tide > Offset  

1.  Select the lines you want to make a tied offset from 

2.  Now select the function. 

3.  Enter the required offset distance in the dialog and click OK. 

4.  At the prompt "point to the side to offset the tied line" click on the side of the line you want to create 
the new tied offset. 

The new line is now added at the offset distance specified and on the side of the line you clicked. 

Please note this is a repeatable command. 

5.  Right click to quit the function. 

Any changes made to the original line will now reflect in the new tied offset line. 

4.  Mirror Line 

Create a new mirror line(s) using the Mirror>Line function found in the New section of the Line menu. 

Line > New > Mirror > Line 

1.  Select the lines you want to mirror. 

2.  Now select the function. 

The lines you selected will now automatically duplicate and mirror across the centre line of the 
standard. 

5.  Rotate Lines 

1.  Select the line you want to rotate 

You will notice the line is surrounded by a series of coloured dots. The green line is used to rotate 
the line; the yellow dot allows you to change the point of rotation. 

2.  Hover the mouse over the green dot until it changes to the rotation cursor. 

6.  Smooth line 

Smooth the selected line(s) by redistributing the nodes using the Smooth>Line function found in the 
Modify section of the Line menu. 

1.  Select the line you want to smooth. 

2.  Now select the function. 

The line is automatically smoothed and as this is a repeatable command, you can continue clicking the 
left mouse button to continue smoothing the line as required. 

3.  Right click the mouse to quit the function. 

ANSWER KEY 4.3.1 

1. Create a new piece: Pieces are created from the style lines you have either generated or digitized and 

will be stored either within an existing and currently selected Packet, or in the default packet that will 

be generated if there is no current packet. 

2. Since pieces are created from style lines you will need to load a style (2D or 3D) into the program. 
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3. Now select the function. 

4. On selection the Piece Name dialog is produced, and you will need to enter a name for the new piece. 

5. When you have entered the required piece name, click OK to proceed. 

6. You will now need to refer to the style and, with the pattern piece you want to create in mind, click on 

the style lines that will make up the pattern piece. For example, to create this pattern: 

It will need to click on the following style lines in order and in a CLOCKWISE direction to generate the 
piece: 

1. When all the lines have been selected, right click to produce a menu. 

2. To complete the piece, you can now select "Complete & Accept", or to complete the piece and continue 

straight to the next piece select "Complete, Accept & New Piece". 

3. Complete this procedure as many times as necessary to make the required patterns. 

Add text to pieces: 

Add text to the selected piece(s) using the New Piece Text function found in the new section of the Piece 
menu. 

Piece > New > New piece text  

1. Select the pieces you want to add text to. 

2. Now select the function to produce the Build Text dialog. 

3. Double click on the text you want to add from the list in the right-hand window. It should now appear 

in the left-hand window. 

4. Click OK to confirm the required text and add it to the centre of the selected pattern. 

Create a default marker 

Create a default marker on a pattern piece using a style line as a point of reference, using the 

Default option found in the Markers from Lines section of the Arc>New menu. 

1.  First select the piece you want to add a marker to. 

2.  Now select the line that you want to use as a reference for the new marker. 

3.  Now select the function from the menu. 

A default marker is automatically added to the pattern piece in the place of the selected style line. 

4.  Add allowances: 

This module shows you how to add various allowances to the arcs of your pieces, for production purposes. 
You will learn how to complete the basic function, which applies to all of the allowance options available. 

Each allowance options add a specific value to the arc(s) you have selected, suitable for the following: 

a. Seam allowance 

b. Fold allowance 

c. Lap allowance 

d. Shear allowance 

1.  Select the pattern piece that you want to add allowances to. 

2.  Now select the relevant arc or arcs. 

3.  Use the Arc drop down menu. 

4.  Select Modify. 

5.  Select Allowance. 

6.  Select the required allowance from the list. 
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7.  Swap lines used in a piece 

Change which line is used by an arc using the Swap Line function found in the Modify section of the Arc 
menu. 

1.  Select the piece to modify and then the arc that you want change. 

2:  Now select the function 

3:  You are now prompted to "point to the line to be used" and can click on the style line that you would 
like to be used in the piece. 

The usage of line is now changed from the original to the newly selected line. The piece will automatically 
reflect the changes. 
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Module 5: Carry out pattern grading 

 

 

MODULE CONTENT 

 

Module Descriptor: This module covers the skills, knowledge and attitudes to carry out pattern grading. 
The module covers the tasks of identifying grading parameters, carrying out grading and checking and 
cutting graded patterns using CAM. It also includes information sheets, job sheets, self-checking, answer 
keys and assessment plan. 

 

Nominal Duration: 12 hours 

 

 

LEARNING OUTCOMES:  

 

Upon completion of the module, the student/trainee should be able to: 

5.1 Identify grading parameters 
5.2 Carry out grading 
5.3 Check and cut graded patterns using CAM 

 
 

 

                      PERFORMANCE CRITERIA: 

 

1. Grading parameters are identified and defined. 
2. Setting rules and default grade type are followed. 
3. Grade setting, and shell grade rules are followed and maintained. 
4. Measurement differences between the sizes are calculated and recorded. 
5. Grading rules are selected, and parameters are applied. 
6. Model size and size range is selected. 
7. Dialog box is followed as per job specification. 
8. Restriction grading areas are checked. 
9. Pattern engineering points are followed.  
10. Graded patterns are prepared and saved.  
11. Graded patterns are cut using CAM. 
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Learning Outcome 5.1 - Identify Grading Parameters 

 

 
 

Contents: 

 

• Grading parameters 

 

 

Assessment criteria: 

 
 
1. Grading parameters are identified and defined. 
2. Setting rules and default grade type are followed. 
3. Grade setting and shell grade rules are followed and maintained. 
4. Measurement differences between the sizes are calculated and recorded. 

 

 

Resources required: 

 

Students/trainees must be provided with the following resources: 

▪ Personal Protective Equipment (PPE): safety shoes, working clothes, apron 

 

 

   LEARNING ACTIVITY 5.1.1 

 

Learning Activity Resources/Special Instructions/References 

Identifying grading parameters ▪ Information Sheet: 5.1.1 

▪ Self-Check: 5.1.1 

▪ Answer Key: 5.1.1 

 

 

 INFORMATION SHEET 5.1.1 

 

Learning Objective: to identify grading parameters. 

What is grading? 

Grading is the process of producing patterns to fit other sizes from one original model size. It is the 
proportional enlargement or reduction of all sample patterns to make a complete range of sizes and fitting 
in a production. Since the shoe last is the basis for shoemaking, the way the patterns for upper and lining 
are graded must follow the last grading. 

The process must be done by following some basic rules and principles. Grading can be carried out by 
CAD CAM software system by reproducing the shape of the patterns in different sizes without changing the 
original proportions. By the way some ‘restrictions’ are needed to ensure a good fit and appearance. 
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A fundamental principle is given by learning that for every style some general steps are followed but, at the 
same time, new and particular details of design and pattern making have to achieve for completion. For 
example: a pump, the typical footwear for women, has different proportions than a women’s derby. The 
specific spring used for making it during the construction is typical and adaptable to several styles 
depending on the design. 

There are two types of grading  

(a) Arithmetic grading  

(b) Geometric grading  

Grading parameters 

o Stick length 

o Bottom length 

o Ball girth 

o Upper girth 

o Bottom width 

o Length increment 

o Girth increment 

Shoe sizing system and their grading increment (mm): 

Sizing system Length increment 
(mm) 

Upper girth increment 
(mm) 

Bottom girth increment 
(mm) 

French/ Paris point/ EU 6.66 3.33 1.67 

English/ UK 8.46 4.23 2.12 

USA 8.46 4.31 2.12 

Japanese (CM) 5.0 3.0 1.5 

Chinese 5.0 2.0 1.0 

 

 

SELF-CHECK QUIZ 5.1.1 

 

Write the correct answer for the following questions. 

1. What is grading? 

2. What are the types of grading? 

3. Name the parameters of grading. 

4. Name the conventional sizing systems. 

5. Write the grading increment according to the sizing system.  
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Learning Outcome 5.2 - Carry Out Grading 

 
 

 

 Contents: 

 

▪ Grading rules 

 

 

Assessment criteria: 

 

1. Grading rules are selected, and parameters are applied. 
2. Model size and size range is selected. 
3. Dialog box is followed as per job specification. 

 

 

Resources required: 

 
 

Students/trainees must be provided with the following resources: 

▪ Personal protective equipment (PPE): Gloves, safety shoes, working clothes, apron 
▪ Tools and equipment: CAD,CAM 
 

  

LEARNING ACTIVITY 5.2.1 

 

Learning Activity Resources/Special Instructions/References 

 Carry out grading ▪ Information Sheet: 5.2.1 

▪ Job Sheet 4 

▪ Self-Check Quiz: 5.2.1 

▪ Answer Key: 5.2.1 

 

 

 INFORMATION SHEET 5.2.1 

 

Learning Objective: to carry out grading. 

Grading rules: 

Shoe pattern grading is done according to the last sizes. While each shoe last will have its own specific 
contours and unique outline shape, the size grading increments are standardized. A grade rule is a 
designated amount a pattern is made larger or smaller at one given point in order to make it fit a range of 
sizes. A grade rule library is a collection of grade rules that will be used to grade a pattern according to the 
desired size specifications. Grading is done by any of the following sizing systems- 

− English/UK system 

− Paris point/French system 
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− Japanese system 

− US system 

2D Normal Grading: 

Set the default grade type 

This function allows you to set the type of grade of you want to apply, choosing from Metric, English or 
Continental. 

1.  Use the following option in the Grade menu to select the function. 

 

2.  Click on the range type you would like to use to automatically set it and complete the procedure. 

Set the shell grade rules: 

This function allows you to set up the rules you want to use for the grading. You will learn how to set the 
width and length distances of the standard and set up the increments for grading. 

Grade > Setting > Set grade rules 

1.  Use the following option in the Grade menu to select the function. 

 

On selection of the function the following dialog is produced which will be used to set up the rules for 
grading. 
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The dialog is divided in four sections. 

The Grade Rule section is the first you will need to consider: 

 

In this section you are setting that you want to grade as the Last using the Arithmetic method. These are 
the default settings used to grade a 2D standard, and the method generally used within the industry. These 
can be changed if required by simply selecting a preferred option. 

The Distance Section is the next section to consider: 

In this section you can set and 
apply the width and length 
distances of the standard. 

1. Click on the Standard 
button. 

2.  You are prompted to "Enter the Girth Point" and will need to make one click in the centre of the standard 
that represents the girth (or widest) point of the standard. 

3.  Click the Apply button. 

4.  Now click the Standard button in the Length section. 

The Length is calculated from the net toe point to the intersection of the heel curves. 

This section is automatically updated, and you will see a figure in the Distance in Length window. 

 

5.  Click the Apply button. 

The Size section is the next section to consider. 

In this section you need to specify the values you use for the 
grading increments. 

1.  Enter a value for the grading increments for both girth and 
length. 

2.  Click Apply in both sections. 

The Fit section is the next section to consider. 

In this section you can specify the values required for fitting, if 
necessary. This section does not have to be completed and is 
generally left blank at this stage; however, if you did need to 
apply increments, you can do so in the following way. 

1.  Enter a value for the grading increments for both girth and 
length. 

2.  Click Apply in both sections. 

This completes the procedure and you can now progress to the 
Set the Size Ranges section. 

Set the size range: 

This function allows you to set up the size range you want to use 
for the grading. 

Grade >Setting > Size range 
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1. Use the following option in the Grade menu to 
select the function. 

2. Tick in the boxes to indicate if you want to use 
whole sizes, and/or half sizes etc. 

3. In the Grade section click the button to 
produce a further dialog. 

4. In this dialog you will need to select or enter 
the size that you want to start grading from. 

5. Click OK to confirm. 

6. Now select the button in the Grade section, to 
produce a further dialog. 

7.  In this dialog you will need to select or enter the size that you want to start grading to. 

8.  Click OK to confirm. 

9.  Now refer to the Model section of the dialog. In this section you will enter a model size and fit. 

10. Click on the Size button to produce a further dialog. 

11. Select or enter the model size you want to use. 

12. Click OK to confirm. 

13. Click on the Fit button to produce a further dialog. 

14. Select or enter the model fit you want to use. 

15. Click OK to confirm. 

16. This completes the process and you can close the dialog. 
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JOB SHEET 4 

Qualification:  Pattern making, grading and CAD CAM operation 

Learning unit: Carry out grading 

Learner 
name: 

 

Personal 
protective 
equipment 
(PPE): 

 

Gloves, safety shoes, working clothes, apron 

Materials: Masking tape, art paper 

Tools and 
equipment: 

Last, scissor, NT cutter 

Performance 
criteria: 

1. Grading parameters are identified and defined. 

2. Setting rules and default grade type are followed. 

3. Grade setting and shell grade rules are followed and maintained. 

4. Measurement differences between the sizes are calculated and recorded. 

5. Grading rules are selected, and parameters are applied. 

6. Model size and size range is selected. 

7. Dialog box is followed as per job specification. 

Drawing, 
Plan, 
Diagram or 
Sketch: 

 

Measurement
: 

• Measurement to be taken perfectly 

• Carefully take the measurement of different reference point   

Notes: 

 

• Use NT cutter carefully. 

• Masking tape should be distributed properly. 
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Procedure: 1. Define and set grading parameters. 

2. Follow setting rules and default grade. 

3. Maintain grade setting and shell grade rules. 

4. Calculate and record measurement differences between the sizes. 

5. Select grading rules and apply parameters. 

6. Select model size and size range. 

7. Check restriction grading areas. 

8. Follow pattern engineering points.  

9. Prepare and saved graded patterns.  

Learner 
signature: 

 Date:  

Assessor 
signature: 

 Date:  

Quality 
Assurer 
signature: 

 Date:  

Assessor 
remarks: 

 

 

 

Feedback:  

 

 

 

 

SELF-CHECK QUIZ 5.2.1 

 
 
Write the appropriate/correct answer of the following: 

1. How are sizing systems generally followed in grading? 

2. What is meant by grading rule? 

3. How do you set the default grade? 

4. How do you set the shell grade rules? 

5. How do you set the size range? 
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 Learning Outcome 5.3 – Check and Cut Graded Patterns Using CAM 

 

 

Contents: 

 
 
▪ Restriction grading areas 
▪ Cutting of prepared and saved graded patterns using CAM 

 

 

Assessment criteria: 

 
 

1. Restriction grading areas are checked. 
2. Pattern engineering points are followed.  
3. Graded patterns are prepared and saved.  
4. Graded patterns are cut using CAM. 

 

  

LEARNING ACTIVITY 5.3.1 

 

Learning Activity Resources/Special Instructions/References 

Checking and cutting of graded patterns using 
CAM 

▪ Information Sheet: 4.3.1 

▪ Job Sheet 5 

▪ Self-Check Quiz: 4.3.1 

▪ Answer Key: 4.3.1 

https://www.youtube.com/watch?v=MEje4AaDxIE 

 

 

 INFORMATION SHEET 5.3.1 

 

Learning Objective: to check and cut graded patterns using CAM. 

Restriction grading areas: 

Restrict lines: This function allows you to restrict the width of a piece, such as a strap that needs to maintain 
a particular size. 

1.  Add a new grade centre and select it. 

 

https://www.youtube.com/watch?v=MEje4AaDxIE
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2.  Use the grade menu and select the restrict function. 

3.  Now enter the value of the restriction in the dialog 

This could be the entire value of the strap distance and 
the restriction held to one line, 

Alternatively, it could be half the value of the strap and 
applied to both sides of the strap. 

When the style is knocked the lines reflect the restrictions 
applied. 

 

 

 

Hold nodes: This function allows you to hold a line to a group at specific node positions 

1.  Add a new grade centre and select it 

2.  Now select the group grade rule, for 
example, As Model 

3:  Now use the following option in the 
Grade menu to select the function. 

Now that the line has been held to the 
model size to the selected node, you 
may wish to apply a natural grade to 
the rest of the line. 

4.  To do this, repeat step 2 and 3 to 
select a group grade option - this time 
Natural and then click on the last node of the line. 

5.  The grade applied to the line can be queried in the Grading menu by selecting Modify> 

Holding and Query and then selecting the line to query. 

As shown in the example below the dialog shows the nodes that have been selected to be held and by 
which group. 

 

Cutting of prepared and saved graded patterns using CAM: 

Cut Shell pattern by plotter machine: First open shell file.  
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Open shell file > Click Redraw Piece > Click Export the current 
view to interface program > Now open Shoemaster interface 
program > Click File > Open the receiver file > Click New Nest 
>Finally click Cut nest.  

Then start pattern cutting by plotter.  
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JOB SHEET 5 

Qualification:  Pattern Making, grading and CAD CAM operation 

Learning unit: Check and cut graded patterns using CAM 

Learner name:  

Personal protective 
equipment (PPE): 

 

Apron, Mask, Safety helmet, Gloves (long), Safety shoes 

Materials: 
 

Tools and 
equipment: 

Plotter (CAM facilities) 

Performance criteria: 1. Restriction grading areas are checked. 

2. Pattern engineering points are followed.  

3. Graded patterns are prepared and saved.  

4. Graded patterns are cut using CAM. 

Drawing, Plan, 
Diagram or Sketch: 

 

Notes: 

 

N/A 

Procedure: 1. Check restriction grading areas. 

2. Follow pattern engineering points.  

3. Check prepared and saved graded patterns.  

4. Cut graded patterns using CAM. 

Learner signature:  Date:  

Assessor signature:  Date:  

Quality Assurer 
signature: 

 Date:  

Assessor remarks: 

 

 

 

Feedback: 
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SELF-CHECK QUIZ 5.3.1 

 
 
Write the appropriate/correct answer of the following: 

1. How do you restrict a line? 

2. How do you hold nodes? 

3. How do you cut shell pattern by plotter? 
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ANSWER KEYS 

 

 

ANSWER KEY 5.1.1 

1.  Grading is the process of producing patterns to fit other sizes from one original model size. It is the 
proportional enlargement or reduction of all sample patterns to make a complete range of sizes and 
fitting in a production. 

2.  There are two types of grading: 

(a) Arithmetic grading  

(b) Geometric grading  

3.  Grading parameters: 

o Stick length 

o Bottom length 

o Ball girth 

o Upper girth 

o Bottom width 

o Length increment 

o Girth increment 

4.  Sizing systems- English/ UK, French/ Paris point/ EU, USA, Japanese (CM), and Chinese 

5.  Shoe sizing system and their grading increment (mm): 

Sizing system 
Length increment 

(mm) 
Upper girth increment 

(mm) 
Bottom girth increment 

(mm) 

French/ Paris point/ EU 6.66 3.33 1.67 

English/ UK 8.46 4.23 2.12 

USA 8.46 4.31 2.12 

Japanese (CM) 5.0 3.0 1.5 

Chinese 5.0 2.0 1.0 

 

ANSWER KEY 5.2.1 

1.  The sizing system generally followed in grading- 

1. English/UK system 

2. Paris point/French system 

3. Japanese system 

4. US system 

2.  A grade rule is a designated amount a pattern is made larger or smaller at one given point in order to 
make it fit a range of sizes. A grade rule library is a collection of grade rules that will be used to grade a 
pattern according to the desired size specifications. 

3.  Set the default grade type: 

This function allows you to set the type of grade of you want to apply, choosing from Metric, English 
or Continental. 

4.  Set the shell grade rules: 
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This function allows you to set up the rules you want to use for the grading. You will learn how to set 
the width and length distances of the standard and set up the increments for grading. 

Grade > Setting > Set grade rules. 

5.  Set the size range: 

This function allows you to set up the size range you want to use for the grading. 

Grade >Setting > Size range 

ANSWER KEY 5.3.1 

1.  Restrict lines: This function allows you to restrict the width of a piece, such as a strap that needs to 
maintain a particular size. 

1.  Add a new grade centre and select it. 

2.  Use the grade menu and select the restrict function. 

3.  Now enter the value of the restriction in the dialog. 

This could be the entire value of the strap distance and the restriction held to one line, 

Alternatively, it could be half the value of the strap and applied to both sides of the strap. 

When the style is knocked the lines reflect the restrictions applied. 

2.  Hold nodes: 

This function allows you to hold a line to a group at specific node positions. 

1.  Add a new grade centre and select it. 

2.  Now select the group grade rule, for example, As Model. 

3:  Now use the following option in the Grade menu to select the function. 

Now that the line has been held to the model size to the selected node, you may wish to apply a 
natural grade to the rest of the line. 

4.  To do this, repeat step 2 and 3 to select a group grade option - this time Natural and then click on 
the last node of the line. 

5.  The grade applied to the line can be queried in the Grading menu by selecting Modify> 

Holding and query and then selecting the line to query. 

3.  Cut Shell pattern by plotter machine:  

First open shell file.  

Open shell file > Click Redraw Piece > Click Export the current view to interface program > Now open 
Shoemaster interface program > Click File > Open the receiver file > Click New Nest >Finally click Cut 
nest.  

Then start pattern cutting by plotter. 

 


